Software FAQ Lists for
PREMIER+ 2 for Mac

PREMIER+ 2 Configure

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

CA001 This action is permanent and may not be reversed. Do you wish to
continue?

This message appears if you try to delete a thread definition from a My Thread database, or to delete a My
Thread database. If you wish to go ahead and delete the thread, click Yes. Otherwise click No.

CA002 The thread XX already exists in the selected Thread Database. Do you
want to overwrite it?

This message appears if you try to use an existing thread name in a My Thread database. If you wish to
overwrite, click Yes. Otherwise click No.

If multiple threads are selected, to overwrite the names click All, otherwise click None.

CA003 Failed to connect to the Cloud: The e-mail address has been recognized
but the password is incorrect

No connection can be made with the software registration database. A correct email address has been used with
an incorrect password. Check the e-mail address and password, and try again.

CA004 Failed to connect to the Cloud: An error has occurred. Please try again.

No connection can be made with the software registration database. An unknown e-mail address was used.
Check the e-mail address and password, and try again.

CcA005 Failed to connect to the Cloud: The e-mail address is incorrectly
formatted.

No connection can be made with the software registration database. The e-mail used is not a valid e-mail
address. Check the e-mail address and password, and try again.

CA006 | receive a warning message when | click the Upload button in Truk 3
Thread Cache

By clicking on the Upload button, you may receive the following message:

"TruE 3 Thread Cache wants to use your confidential information stored in "threads.truembroidery.com"
in your keychain.



The authenticity of "TruE 3 Thread Cache" cannot be verified. Do you want to allow access to this item?"

This message generated by the Mac® operating system; is appearing because you will be prompted to enter your
E-mail address/Password details that you use to connect to the Registration Database.
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ccoo02 Application could not be shut down. PREMIER+™ 2 XX could not be quit.
Please shut this app down manually.

This message is displayed if you select Quit Open PREMIER+™ 2 Apps in Reset All Apps when, for instance, a
dialog is open or you have unsaved changes in a PREMIER+™ 2 Embroidery System app. Click OK, and then
shut the app down manually.

cco03 The value *mm’ needs to be in the range 1 to 3mm. Please provide a
valid value.

This message appears if the tolerance value entered in the box on the Export tab is below 1mm or above 3mm, or
is not a number. Enter a number within the valid range.

Ccco04 The value *mm’ needs to be in the range 5 to 200mm. Please provide a
valid value.

This message appears if the value entered in the Real Size box on the Appearance tab is below 5mm or above
200mm, or is not a number. Enter a number within the valid range.

ccoo5 Restoring your settings will overwrite the current settings.

This message is displayed when you click Restore My Settings in the Utilities tab. Click OK, or click Cancel to
keep your current settings.

ccooé Reset All Apps: To reset all applications correctly, you must ensure that
no PREMIER+™ 2 apps are open.

This message is displayed if you select Reset All Apps in the Utilities tab while other PREMIER+™ 2 Embroidery
System apps are running. Click Cancel, or use Quit Open PREMIER+™ 2 Apps to close all open apps.



ccoo8 How do | activate my software?

You can activate your software when installing. Alternatively, select the Register button in PREMIER+™ 2
Configure at any time to activate. Once you have activated, your activation code is in your registration entry.

ccoo9 How can | move my activation to another computer?

You can move your activation to another computer.

In the Utilities page of PREMIER+™ 2 Configure click the Activate button and sign in to your Registration
account.

1. On the Enter Your Product Activation Codes page click 'l would like to remove my Activation from this
computer'.

2. Click OK to remove the activation from the computer.

You will then be able to install and activate your software on another computer.
Your activation code is in your registration entry.

cco10 When upgrading my Mac® operating system, my activation was lost.
What should | do?

Update the Applications in your PREMIER+™ 2 Embroidery System to the latest version. Then, in PREMIER+™
2 Configure select Activate and reactivate using your current Activation Code.

Before PREMIER+™ 2 Mac Applications 12.1.1, an activation could be broken when macOS was updated. This is
resolved in version 12.1.1.

We strongly recommend that after you update to 12.1.1 from 12.0 or 12.1, you run Activate again in PREMIER+™
2 Configure using your current Activation Code, to move to the new activation method.

Note: This updates your current activation, it does not use a new activation.

cco11 Why does my Mac® show PREMIER+™ 2 Embroidery Free?

Your Mac® will show PREMIER+™ 2 Embroidery Free if you do not have a license for the PREMIER+™ 2
Embroidery System, or if your activation has become corrupted.

If you are using PREMIER+™ 2 Embroidery Free, you do not need to do anything.

To activate or repair your installation, install the latest version of Applications for your PREMIER+™ 2 Embroidery
System. In PREMIER+™ 2 Configure select Activate and activate using your Activation Code.

Note: Repairing an existing activation will not use up a second activation.

EC003 Can | set the PREMIER+™ 2 Machine app to start automatically when |
turn on my computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System area, click on Users & Groups.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right pane of that window.

. Click on the + icon on the right pane of that window. An Open dialog will appear.

. On the left pane - under the Favorites section; click on the Applications entry.

. In the right pane, scroll down the list of apps until you come to the PREMIER+™ 2 Machine entry.

. Select the PREMIER+™ 2 Machine entry and click on the Add button.

. You will now see PREMIER+™ 2 Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.

O©oo~NO O~

When you next log into your computer; the PREMIER+™ 2 Machine app will run automatically.



EC004 Can | connect more than one embroidery machine to my computer with
PREMIER+™ 2 Machine?

No, you are not able to connect two embroidery machines at the same time, and to send a design to the first
embroidery machine and then to the second embroidery machine.

If you want to send an embroidery to two machines, do as follows

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the PREMIER+™ 2 Machine app is running. PREMIER+™ 2 Machine appears as a machine
icon in the menu bar.

If PREMIER+™ 2 Machine is not running, start it.

e Click the PREMIER+™ 2 Machine icon in the Launchpad, or double-click the PREMIER+™ 2 Machine icon
in the Finder.

Second, confirm that the PREMIER+™ 2 Machine app is communicating with your embroidery machine.

o Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start PREMIER+™ 2 Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart PREMIER+™ 2 Machine.

EC006 | sent a design to my embroidery machine, but nothing happened.

You can only send a design directly to your embroidery machine if the following folder exists:
ILibrary/Application Support/VsmSoftware/Premier+2/TempSend.
If this folder does not exist, do as follows:

1. Open a Finder window.

2. In the Go menu, hold down the Option key and choose Library.

3. Browse to Application Support/VsmSoftware/Premier+2.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

Now try to send the design again.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.
You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome

MC350E the embroidery files must be placed in the EMBS5 folder, while for the MC11000 and MC 12000 they must
be placed in the Embf folder.



GA002 Error: "Exporting to XX failed. The design was too big for the export
format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GE001 | cannot open Melco (.exp) files in the PREMIER+™ 2 Embroidery
software.

The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert to use those designs in your PREMIER+™ 2 Embroidery System software.

GE002 Some of the items in a menu are dimmed.

Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."

Use PREMIER+™ 2 Configure to change the grid color. Click the Color block and the Colors window appears to
allow you to choose a color. The color set by default for your PREMIER+™ 2 Software is 127, 127, 127 (RGB).
You can use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use PREMIER+™ 2 Configure to change screen background color. Click the Color block and the Colors window
appears to allow you to choose a color. The color set by default for your PREMIER+™ 2 Embroidery System is
211, 233, 255 (RGB). You can use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in PREMIER+™ 2 Configure to return the toolbar and windows in the app to their default
settings.

To return the buttons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the
default button set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System apps that are open.

2. Click the PREMIER+™ 2 Configure icon in the Launchpad, or double-click the PREMIER+™ 2 Configure
icon in the Finder.

. Click the Utilities tab.

. Click Reset All Apps.

. Click the Quit Open PREMIER+™ 2 Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some PREMIER+™ 2 apps are still open, a message appears, saying that some apps appear to be
running. Click OK to close all running PREMIER+™ 2 apps, or click Cancel.

[oJN) I - V]

The toolbar and windows in your app will have been restored to their original state.



Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE007 When | try to use the number box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired
thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color is replaced with the nearest match in the Import
Thread Range you have set in PREMIER+™ 2 Configure. You can alter it to any other color if desired. To check
for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE031 Not enough memory available to perform function.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE032 Cannot open stitch file.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE039 Information About Colors in PREMIER+™ 2 Embroidery System Files

The PREMIER+™ 2 Embroidery System will display threads in a file in the same way on any computer where it is
installed. That is, the colors used will be the same even if they are reproduced slightly differently on different
monitors. You can print a worksheet to see the colors and color names used in a particular design. This is true,
even if you do not have all the threads in a design defined in the database on your computer. This is because a
PREMIER+™ 2 Embroidery System design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

» Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the PREMIER+™ 2 Embroidery System
where you can change colors, as follows:

» Editing apps: PREMIER+™ 2 Embroidery and PREMIER+™ 2 Modify
» Design apps: PREMIER+™ 2 Create



» Adding/Editing Thread: PREMIER+™ 2 Thread Cache
» Generating fonts: PREMIER+™ 2 QuickFont

In GEO40 and GE041 are some situations you may encounter according to the availability of thread definitions, as
categorized above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

GE041 | have a vp4 or vp3 embroidery from another user that uses a custom
thread definition they designed.

If you attempt to change the color the nearest match will be selected. If desired, select a replacement thread.

GE045 Exporting SHV designs to my USB Embroidery Stick seems slow.

The process of exporting SHV designs to a USB Embroidery stick may take up to a few minutes.

When the 'Exporting to USB Stick' progress bar disappears; then the designs have written to the USB Embroidery
Stick.

Be sure to go to Finder and Eject your USB Stick before removing it from the computer and inserting it into your
Designer 1 USB machine.

GE046 When | export SHV files to my USB Embroidery Stick, it does not appear
to have written the designs to the USB Stick.

It may be that your USB Embroidery Stick is running very low on space.

It is advisable to format your USB Embroidery Stick to ensure that it has enough space for your SHV designs to
be written.

The following formatting process will delete ALL files/folders from your USB Embroidery Stick. If you have any
files/folders that you wanted to keep, then backup them up before proceeding with the following procedure.

. Eject and then remove all USB Sticks/Hard Disk from your Mac®.

. Insert your USB Embroidery Stick that you would like to format.

. Open Finder.

. Click on the Go menu.

. Click on the Home option.

. Browse to .../Premier+2/Samples/Finder/Stitch/Animals

. Control+click on any .vp3 or .vp4 file shown. A context menu will appear.

. Move your mouse to the Services sub-menu

. Click on the Premier+ 2 Convert option. APREMIER+™ 2 Convert box should appear.
10. Click on the ... button in the Output File Type section.

11. Select Husqvarna Viking Designer 1 (.shv) from the list.

12. Click on the USB Stick button in the Select Device section

13. Click on the Format button in that section. A warning will appear.

14. After you have read and accepted the warning, click Yes to start the Formatting process.
15. The formatting process should take less than a minute.

16. When it is complete, try to export your SHV designs again to the USB Embroidery Stick.

OOONOOAPRWN -

GE047 How do | change the measurement in the PREMIER+™ 2 software?

The measurements are taken from the settings on the Appearance tab in PREMIER+™ 2 Configure.
To change those settings, do the following:



1. Go to the Launchpad.

2. Open PREMIER+™ 2 Configure.

3. Click on the Appearance tab.

4. From the Show Measurements In: section, either choose Millimeters (mm) or Inches (“).

GE048 | have a Husqgvarna Viking Designer | machine; how do | create a SHV
design?

You would need to choose Husqvarna Viking Designer |1 from the Export dialog:

1. Click on the File menu

2. Choose Export.

3. Select Husqvarna Viking Designer | (.shv) from the drop-down list.

4. Depending on which device (floppy disk or USB Embroidery Stick) you are write to, you will click on the
appropriate icon for that device.

5. [Optional] to backup the items already on your floppy disk/lUSB Embroidery Stick; click on the Read
Stick or Disk button and then choose the location to save your backup to.

6. Click on the Next button to start writing to that device.

N.B. The instructions above are only applicable to PREMIER+™ 2 EMBROIDERY, PREMIER+™ 2 EXTRA or
PREMIER+™ 2 ULTRA owners with activated software.

GE049 | cannot see all my PREMIER+™ 2 icons in Launchpad.

Launchpad shows the icons for all your installed software on your Mac® computer.

Depending on how many apps you have installed on your Mac®; the icons may span more than one page in
Launchpad .

When there is more than one page of icons available in Launchpad , there will be a number of ‘dots’ —
representing all the available Launchpad pages. The dot for the current page will be highlighted, click on one of
the other dots to navigate between pages.

IN001 This package will run a program to determine if the software can be
Installed.

This message appears when installing the Samples or Bonus Designs. Click Continue to proceed with the
installation if the software has already been activated. Otherwise, activate your software, and then install the
Samples or Bonus Designs.

IN021  Where are my samples/backgrounds/documents/bonus designs?

When installing any of the PREMIER+™ 2 Embroidery System samples/backgrounds/documents/bonus designs
the files should be installed in subfolders of the folder /Users/Home/Premier+2/ (where Home means the account
of the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.



If you are not at the computer with PREMIER+™ 2 Embroidery, you can enter your e-mail address and password
to find your registration details.

TCc127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE 3 Embroidery System as a result of upgrading to the latest
Mac OS Update

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True 3 Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery 3 Software section, download the latest TruEmbroidery3Software32.pkg file.

. Close down all TruEmbroidery 3 System Apps.

. Install the TruEmbroidery3Software32.pkg file that you just downloaded.

. Open TruE 3 Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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TC129 Delete My Fill: Are you sure you want to delect the selected pattern? This
action cannot be undone.

This message appears when you delete a My Fill pattern from the Manage My Fills dialog. Click Yes or No, as
desired.

PREMIER+ 2 Create

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

ccoo1 Warning. Some PREMIER+ 2 apps still appear to be running. Do you
really want to reset all modules?

This message is displayed if you select Reset All Apps in the Utilities tab while other PREMIER+™ 2 Software
apps are running. Click Cancel, or use Quit Open PREMIER+ 2 Apps to close all open apps.

cco10 When upgrading my Mac® operating system, my activation was lost.
What should | do?

Update the Applications in your PREMIER+™ 2 Embroidery System to the latest version. Then, in PREMIER+™
2 Configure select Activate and reactivate using your current Activation Code.

Before PREMIER+™ 2 Mac Applications 12.1.1, an activation could be broken when macOS was updated. This is
resolved in version 12.1.1.

We strongly recommend that after you update to 12.1.1 from 12.0 or 12.1, you run Activate again in PREMIER+™
2 Configure using your current Activation Code, to move to the new activation method.

Note: This updates your current activation, it does not use a new activation.



EC003 Can | set the PREMIER+™ 2 Machine app to start automatically when |
turn on my computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System area, click on Users & Groups.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right pane of that window.

. Click on the + icon on the right pane of that window. An Open dialog will appear.

. On the left pane - under the Favorites section; click on the Applications entry.

. In the right pane, scroll down the list of apps until you come to the PREMIER+™ 2 Machine entry.

. Select the PREMIER+™ 2 Machine entry and click on the Add button.

. You will now see PREMIER+™ 2 Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.

O©oo~NO O~

When you next log into your computer; the PREMIER+™ 2 Machine app will run automatically.

EC004 Can | connect more than one embroidery machine to my computer with
PREMIER+™ 2 Machine?

No, you are not able to connect two embroidery machines at the same time, and to send a design to the first
embroidery machine and then to the second embroidery machine.

If you want to send an embroidery to two machines, do as follows

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the PREMIER+™ 2 Machine app is running. PREMIER+™ 2 Machine appears as a machine
icon in the menu bar.

If PREMIER+™ 2 Machine is not running, start it.

e Click the PREMIER+™ 2 Machine icon in the Launchpad, or double-click the PREMIER+™ 2 Machine icon
in the Finder.

Second, confirm that the PREMIER+™ 2 Machine app is communicating with your embroidery machine.

» Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start PREMIER+™ 2 Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart PREMIER+™ 2 Machine.

EC006 | sent a design to my embroidery machine, but nothing happened.

You can only send a design directly to your embroidery machine if the following folder exists:
ILibrary/Application Support/VsmSoftware/Premier+2/TempSend.
If this folder does not exist, do as follows:

1. Open a Finder window.

2. In the Go menu, hold down the Option key and choose Library.

3. Browse to Application Support/VsmSoftware/Premier+2.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

Now try to send the design again.



EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMB5 folder, while for the MC11000 and MC 12000 they must
be placed in the Embf folder.

GA002 Error: "Exporting to XX failed. The design was too big for the export
format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"{" "2", and so on.

GA005 Error "Feature not available in this version."

This message appears when trying to start a module or feature if the PREMIER+™ 2 Embroidery System cannot
detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE001 | cannot open Melco (.exp) files in the PREMIER+™ 2 Embroidery
software.

The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert to use those designs in your PREMIER+™ 2 Embroidery System software.

GE002 Some of the items in a menu are dimmed.



Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."

Use PREMIER+™ 2 Configure to change the grid color. Click the Color block and the Colors window appears to
allow you to choose a color. The color set by default for your PREMIER+™ 2 Software is 127, 127, 127 (RGB).
You can use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use PREMIER+™ 2 Configure to change screen background color. Click the Color block and the Colors window
appears to allow you to choose a color. The color set by default for your PREMIER+™ 2 Embroidery System is
211, 233, 255 (RGB). You can use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in PREMIER+™ 2 Configure to return the toolbar and windows in the app to their default
settings.

To return the buttons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the
default button set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System apps that are open.

2. Click the PREMIER+™ 2 Configure icon in the Launchpad, or double-click the PREMIER+™ 2 Configure
icon in the Finder.

. Click the Utilities tab.

. Click Reset All Apps.

. Click the Quit Open PREMIER+™ 2 Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some PREMIER+™ 2 apps are still open, a message appears, saying that some apps appear to be
running. Click OK to close all running PREMIER+™ 2 apps, or click Cancel.
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The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE007 When | try to use the number box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired

thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by



someone with a later version of the thread database. The color is replaced with the nearest match in the Import
Thread Range you have set in PREMIER+™ 2 Configure. You can alter it to any other color if desired. To check
for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GE009 When | open a picture the name is displayed, but | cannot see the picture
and Continue is dimmed.

This can happen if the desired picture is corrupt. For example, it might have an extension such as .bmp or .jpg,
yet not be a proper picture file.

GE012 The file XX is locked. If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy, click Duplicate.

This message appears when trying to edit an embroidery design outline which is locked, or is on a read-only
medium such as a CD-R. Unlock the embroidery design outline before editing, or duplicate it and then edit it, if it
is on a read-only medium.

GE013 The file XX is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery design outline which is on a read-only medium such
as a CD-R. Duplicate it, then edit and save it.

GE014 The file doesn’t exist.

This message appears if the desired design is not where the app expects it to be, for example if a design was
saved to a network drive, then deleted or renamed.

The message would appear if you tried to load the design from the Open Recent list on the File menu.

GE015 Unrecognized file format.

This message appears if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE016 Unrecognized file extension.

This message may appear if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE017 Background Image Warning. This will remove your existing image,
continue?

This message appears if you try to load a background image when an image has already been loaded. Click OK
to load a new image, or Cancel to use your existing image.

GE018 Background Image Error. Could not open the background image.

This message appears if you try to load a background image and the picture is corrupt. For example, it might
have an extension such as .bmp or .jpg, yet not be a proper picture file.



GE019 The document XX could not be saved as XX. The volume is read only. Try
saving the file to another volume.

This message appears if, for instance, you try to save an embroidery design to a CD-R. A CD-R is read only,
therefore you will not be able to save the embroidery design. Save the embroidery design to another medium .

GE020 The document XX could not be autosaved. The volume is read only. Try
saving the file to another volume. You can also duplicate the document or discard
your changes to close it.

This message appears if, for instance, you have loaded an embroidery design from a CD-R and then attempt to
save the embroidery design back to the CD. A CD-R is read only, therefore you will not be able to save the
embroidery design. Save the embroidery design to another medium .

GE021 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Save has a name that has already been used. Replace
the existing embroidery, or choose a new name before saving.

GE022 Embroidery is too large or will not fit in hoop.

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you choose Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again. Alternatively, change the size
of the hoop.

GE023 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Export has a name that has already been used. Replace
the existing embroidery, or choose a new name before exporting.

GE024 Exporting to XX failed. The design was too big for the export format.

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GE025 Print. Embroidery is too large or will not fit in hoop.

This message appears if the embroidery on screen is partially outside the selected hoop. Move the embroidery
completely within the four blue corners of the work area and try again, or change the hoop size

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE027 Not For Sale. This is a Dealer version of the PREMIER+™ 2 Embroidery
System and not for retail sale. If you are not a certified registered PREMIER+™ 2



Embroidery System dealer you are not entitled to use this software. Please
contact your local dealer for further information.

This message means that the app is a dealer only version for demonstration and training purposes, and is not
available for retail sale. Please contact software support for further information.

GE028 Could not understand the string XX.

This message appears if the value entered in a number box is outside the valid range, or is not a number.

GE029 The file doesn’t exist.

This message appears if the desired embroidery is not where the app expects it to be, for example if an
embroidery was saved to a network drive, then deleted or renamed. The message would appear if you tried to
load the embroidery from the Open Recent list on the File menu.

GE030 Unrecognized file format.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqvarna Viking/Pfaff embroidery.

GE031 Not enough memory available to perform function.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqvarna Viking/Pfaff embroidery.

GE032 Cannot open stitch file.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husgvarna Viking/Pfaff embroidery.

GE033 Unrecognized file extension.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqvarna Viking/Pfaff embroidery

GE034 Stitch file is corrupt.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE035 Stitch file XY coordinates incorrect.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE036 The document "xx" could not be opened.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE037 The file "xx" is locked. If you want to make changes to this document,
click Unlock. To keep the file unchanged and work with a copy, click Duplicate



This message appears when trying to edit an embroidery which is locked, or is on a read-only medium such as a
CD-R. Unlock the embroidery before editing, or duplicate it, and then edit it, if it is on a read-only medium

GE038 The file "xx" is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery which is on a readonly medium such as a CD-R.
Duplicate it, then edit and save it.

GE039 Information About Colors in PREMIER+™ 2 Embroidery System Files

The PREMIER+™ 2 Embroidery System will display threads in a file in the same way on any computer where it is
installed. That is, the colors used will be the same even if they are reproduced slightly differently on different
monitors. You can print a worksheet to see the colors and color names used in a particular design. This is true,
even if you do not have all the threads in a design defined in the database on your computer. This is because a
PREMIER+™ 2 Embroidery System design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

o Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the PREMIER+™ 2 Embroidery System
where you can change colors, as follows:

« Editing apps: PREMIER+™ 2 Embroidery and PREMIER+™ 2 Modify
» Design apps: PREMIER+™ 2 Create

» Adding/Editing Thread: PREMIER+™ 2 Thread Cache

» Generating fonts: PREMIER+™ 2 QuickFont

In GE040 and GE041 are some situations you may encounter according to the availability of thread definitions, as
categorized above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

GE041 | have a vp4 or vp3 embroidery from another user that uses a custom
thread definition they designed.

If you attempt to change the color the nearest match will be selected. If desired, select a replacement thread.

GE042 Do you want to remove all points from your demo? This cannot be
undone.

This message appears if you use Reset My Demo in Life View. Click Yes to continue, or No to keep your existing
My Demo.

GE043 How do | backup a My Demo animation?

The My Demo animated preview is stored in the AnimationPath.txt file in the folder
/User]/Library/ApplicationSupport/VSMSoftware/Premier+2/System. This location may not be visible on your
Mac®, but you can find it using the following steps.



To Backup a My Demo Animation

1. Open the Finder window.

2. Open the Go menu.

3. Hold down the Option (Alt) key, and choose Library.

4. Browse to /ApplicationSupport/VSMSoftware/Premier+2/System.
5. Copy the file AnimationPath.txt to your backup location.

| recently captured an image using a camera in a PREMIER+™ 2 Assistant.

Images that have recently been captured using your webcam in one of our PREMIER+™ 2 Assistants can be
found in /User]/Library/Containers/com.apple.ImageKit.RecentPictureService/Data/Library/Images/Recent
Pictures. This location may not be visible on your Mac®, but you can find it using the following steps.

To Manage Recent Pictures Taken By Your Webcam

. Open the Finder window.

. Open the Go menu.

. Hold down the Option (Alt) key, and choose Library.

. Browse to
/User]/Library/Containers/com.apple.ImageKit.RecentPictureService/Data/Library/Images/Recent
Pictures.

. Open the View menu in Finder.

. Click on the as Icons option to have a better view of the individual images.

. Manage the .png or .tiff files in that folder as needed.
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The process of exporting SHV designs to a USB Embroidery stick may take up to a few minutes.

When the 'Exporting to USB Stick' progress bar disappears; then the designs have written to the USB Embroidery
Stick.

Be sure to go to Finder and Eject your USB Stick before removing it from the computer and inserting it into your
Designer 1 USB machine.

It may be that your USB Embroidery Stick is running very low on space.

It is advisable to format your USB Embroidery Stick to ensure that it has enough space for your SHV designs to
be written.

The following formatting process will delete ALL files/folders from your USB Embroidery Stick. If you have any
files/folders that you wanted to keep, then backup them up before proceeding with the following procedure.

. Eject and then remove all USB Sticks/Hard Disk from your Mac®.

. Insert your USB Embroidery Stick that you would like to format.

. Open Finder.

. Click on the Go menu.

. Click on the Home option.

. Browse to .../Premier+2/Samples/Finder/Stitch/Animals

. Control+click on any .vp3 or .vp4 file shown. A context menu will appear.

. Move your mouse to the Services sub-menu

. Click on the Premier+ 2 Convert option. APREMIER+™ 2 Convert box should appear.
10. Click on the ... button in the Output File Type section.

11. Select Husqvarna Viking Designer 1 (.shv) from the list.

12. Click on the USB Stick button in the Select Device section

13. Click on the Format button in that section. A warning will appear.

14. After you have read and accepted the warning, click Yes to start the Formatting process.
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15. The formatting process should take less than a minute.
16. When it is complete, try to export your SHV designs again to the USB Embroidery Stick.

GE047 How do | change the measurement in the PREMIER+™ 2 software?

The measurements are taken from the settings on the Appearance tab in PREMIER+™ 2 Configure.
To change those settings, do the following:

1. Go to the Launchpad.

2. Open PREMIER+™ 2 Configure.

3. Click on the Appearance tab.

4. From the Show Measurements In: section, either choose Millimeters (mm) or Inches (“).

GE048 | have a Husqvarna Viking Designer | machine; how do | create a SHV
design?

You would need to choose Husqvarna Viking Designer | from the Export dialog:

1. Click on the File menu

2. Choose Export.

3. Select Husqvarna Viking Designer | (.shv) from the drop-down list.

4. Depending on which device (floppy disk or USB Embroidery Stick) you are write to, you will click on the
appropriate icon for that device.

5. [Optional] to backup the items already on your floppy disk/lUSB Embroidery Stick; click on the Read
Stick or Disk button and then choose the location to save your backup to.

6. Click on the Next button to start writing to that device.

N.B. The instructions above are only applicable to PREMIER+™ 2 EMBROIDERY, PREMIER+™ 2 EXTRA or
PREMIER+™ 2 ULTRA owners with activated software.

GE049 | cannot see all my PREMIER+™ 2 icons in Launchpad.

Launchpad shows the icons for all your installed software on your Mac® computer.

Depending on how many apps you have installed on your Mac®; the icons may span more than one page in
Launchpad .

When there is more than one page of icons available in Launchpad , there will be a number of ‘dots’ —
representing all the available Launchpad pages. The dot for the current page will be highlighted, click on one of
the other dots to navigate between pages.

GE050 Error: "Exporting to XX failed."

This message appears if, for instance, you attempt to save the design to a CD. A CD-ROM is read only, therefore
you will not be able to save the design.

GE054 Error: The value mm’ needs to be in the range XX to YY mm. Please
provide a valid value.

This message appears if the value entered in the number box is below the permitted minimum or above the
permitted maximum.

IN001 This package will run a program to determine if the software can be
Installed.

This message appears when installing the Samples or Bonus Designs. Click Continue to proceed with the
installation if the software has already been activated. Otherwise, activate your software, and then install the



Samples or Bonus Designs.

IN021 Where are my samples/backgrounds/documents/bonus designs?

When installing any of the PREMIER+™ 2 Embroidery System samples/backgrounds/documents/bonus designs
the files should be installed in subfolders of the folder /Users/Home/Premier+2/ (where Home means the account
of the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.

If you are not at the computer with PREMIER+™ 2 Embroidery, you can enter your e-mail address and password
to find your registration details.

sT004 ColorSort does not work for the multi-color monogram that | created

When creating multi-color lettering, ensure that the Trim Connection is selected. If Running Connection is
selected, you will not be able to ColorSort the lettering.

sT006 When | ColorSort an embroidery the number of color blocks produced
varies

The ColorSort process does not just put the same color blocks together. It checks for overlap between areas,
therefore depending on the overlaps, the final number of color blocks may vary, even if you are Combining a
similar number of SuperDesigns or monograms.

sT011 Error: "Embroidery is too large or not in the hoop"

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again.

sT012 Error: "Embroidery is too large or will not fit in hoop" when printing

This error can occur when an embroidery design(s) are partially outside of the hoop area when you try to print.
Move the design(s) so that they are entirely within the hoop area; or alternatively use a larger hoop.

sT018 The embroidery | want to work with appears too small on the screen

Make sure the PREMIER+™ 2 Embroidery window is maximized by choosing Window > Zoom. Click Zoom To Fit
to expand the hoop so it fills the work area. Also, choose a Hoop Size in Hoop Selection that is suitable to the
embroidery size.



sT019 | find it hard to select the part of the embroidery | wish to edit

Many functions of PREMIER+™ 2 Embroidery can be used to help see sections of embroideries more easily.
They include the Zoom slider and the different methods of selection (Box Select, Freehand Select and Freehand
Point Select). Use Command and the left or right arrow (38« or 3£—) to select each embroidery in turn.

sT029 | have increased the Gap setting, but the lowercase characters are still
touching each other

For script fonts, the Gap setting has no effect on adjacent lowercase characters. Script fonts use a special
‘continuous' joining method, which places lowercase characters adjacent to each other to give the appearance of
handwriting. All the fonts in the Script category use this joining method.

sT030 All the lettering appears in uppercase, even though | have entered
lowercase characters in the Letters box

You are using an uppercase font. In an uppercase font (with UC in the name), all the lowercase characters are
identical to the uppercase characters.

sT038 | have selected the correct hoop size, but the graphical representation
does not look the same as my real hoop

This will happen if you choose a Universal Hoop that is the same size. The Universal Hoops are shown as plain
hoops of the selected size. Use Hoop Selection to choose the desired hoop size, but do not choose a Universal
Hoop.

TC009 The fill shape created with QuickStitch™ Fill when | click inside the area
is not the one | want

The pictures used should have well differentiated color areas, which should be solid, to fill easily. Clip art is
excellent for this purpose.

If Color Tolerance is switched off then switch it on in PREMIER+™ 2 Create menu -> Preferences... -> Color
Tolerance for QuickStitch Tools checkbox.

Color Tolerance will then allow you to preview any area for QuickStitch™ functions, which should reveal any
problems with color areas in the picture. Alter the picture before reloading it as a Background image. Alternatively,
use the Freehand or Precise Create functions to place the Fill Area.

TCco10 How do | change the color of the border of my Freehand Create, Precise
Create or QuickStitch™ fill area?

To change the color of the border, create the fill area using one of the Create or QuickStitch™functions. Both the
fill area and the border will use the current thread color.

. Select the Fill area that you would like to edit.

. Ctrl + click to bring up the context menu.

. Click Properties to bring up the Fill Properties dialog for that Fill area.

. Click on the Line tab.

. Select the Insert Color Change option.

. Click on the Color Selection button - three colored circles; this will bring up the Color Selection dialog.
. Select your Thread Color.

. Click OK to close the Color Selection dialog

. Click OK again to close the Fill Properties dialog.
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Your work area will now show the object has a separate color for the border.



TC024 Error "Trace Failed. Maybe the image is too thick?"

This happens when you use QuickTrace to follow an outline in the picture and then QuickTrace finds a part of
the outline that is very thick. This can be caused by excessively broad outlines or by selecting too much of the
picture with a high Color Tolerance value. In this case, QuickTrace does not know where to trace the outline as
the problem part of the outline is more like a fill area.

Try using a lower Color Tolerance value

TC029 The border shape created with QuickStitch™ functions when | click inside
the area is not the one | want

Use Color Tolerance to preview the area that will be used.

» Solid Colors. A solid color area must have well defined edges, either by having an outline of a different color
or by being enclosed by other colors. Color Tolerance will show where there are gaps in a border around
an area.

» Stippled Colors. Stippled colors (also called 'dithered' colors) are treated the same as solid color areas.

» Graduated Colors. If Color Tolerance is switched off then you will only be able to select a small, single
colored part of a graduated color. It is also easier to select a graduated color area when it is enclosed by
contrasting colors.

Color Tolerance is switched on with the Color Tolerance for QuickStitch Tools option in PREMIER+™ 2
Create menu -> Preferences...

Alternatively, use the relevant Freehand Create or Precise Create function.

TCco61 | did not select all the objects | wanted with Box, Freehand or Freehand
Point Select

Objects must be fully enclosed by the selection line to be selected as part of a block. If even the smallest part of
an object is outside the line then it will not be selected.

TCco064 | have created a satin border with Satin Line Trace but | can't change the
width of it all at once

Use the FilmStrip and/or slider bars to hide all objects except the satin borders and traveling running stitch used
to create the trace.

Select any satin border object in the trace, then Ctrl-click in the FilmStrip and select Global Properties. The
Satin Line properties dialog box will appear. Make adjustments as desired and click OK. The new properties will
be applied to all visible satin borders.

TCco65 Color Tolerance does not show me all the lines that will be traced by a
QuickTrace function

The dashed line used by Color Tolerance only shows the outside of the area that is selected by the current
Color Tolerance value. Simply try the QuickTrace function and if the result is not satisfactory then Undo the
result and retry the trace with a higher Color Tolerance.

TCc066 There is no underlay under a fill area
This will happen when you select Gradient or Multi-Gradient Density for a fill area. Underlay stitches are only
generated for fill areas with Constant Density selected.

This is because the underlay stitching will spoil the effect of Gradient or Multi-Gradient Density. With Constant
Density selected, some fill areas with intricate outlines or complex holes may not be able to create underlay.



TCco67 The Gradient or Multi-Gradient Density on my fill area does not change
very smoothly

If you have a fill area with a complex outline then this may cause the stitches to fill unevenly when you select
Gradient or Multi-Gradient density. This is because of the way that the edge of the area interferes with the ideal
spacing of the stitches.

Gradient and Multi-Gradient density work best for areas with straight or smoothly curving sides. You could replace
the Fill Area with a Precise Create fill, or edit the area to straighten the side that causes the uneven stitches.

Tco77 | am looking for the origin of my fill area, but there is no orange circle.

The origin is usually shown as a medium orange circle. The origin can be moved anywhere on the work area. Try
Zoom To Fit to see the whole work area.

TC078 The size of my embroidery in the dialog is bigger than the height or width |
entered, or the hoop size.

If you edit the outermost areas of a design, for example by changing satin column to feathered satin, the size of
the actual embroidery may exceed the original height or width of the design.

TCc079 The fill shape created with QuickStitch™ when | click inside the area is
not the one | want."

The pictures used should have well differentiated color areas, which may be solid or stippled, to fill easily. Clipart
is excellent for this purpose. If there is a gap where the same color flows into another area, the fill will not work as
expected. If Color Tolerance is switched off then switch it on in Preferences. Color Tolerance will then allow you to
preview any area for QuickStitch™ functions, which should reveal any problems with color areas in the picture.
You can then alter the picture in a picture editor such as Preview. Alternatively, use the Freehand or Precise
functions to place the Fill Area.

TCc080 None of the picture is selected for QuickStitch™ when | click inside a
small color area."

QuickStitch™ will not create an area from part of the picture that is very small or very thin. This is because the
area will either have insignificantly few stitches, or it is not wide enough for stitches to go across it. Use Color
Tolerance, or try editing your picture to enlarge the area, so that it is big enough to be used as a QuickStitch™
area. Alternatively, use single or running stitches. For thin lines, use one of the Trace functions.

TCco81 | am looking for the origin of my fill area, but there is no orange circle.

The origin for a Pattern, Shape, Radial or Spiral fill is usually shown as an orange circle. It may be a different
color, depending the underlying picture or background colors. Also, the origin can be moved anywhere on the
work area. Try Zoom To Fit to see the whole work area.

TC082 \When | create stitches one of my fill areas doesn't fill completely with
stitches."

Try changing the angle of orientation. Even one degree can be enough to allow the artificial intelligence of the
program to fill the object. Another possibility is to move the start point slightly.

TC083 \When | use motif fill areas, the design takes a long time to appear.



On slower computers, large or complex motif fill areas may take some time to draw, particularly if there are holes
in the area. This may be noticeable when you create new motif fill areas and when you return to PREMIER+™ 2
Create from another PREMIER+™ 2 Embroidery System app.

TC084 The border line created by QuickStitch™ Satin Line/Running
Stitch/Double Stitch/Triple Stitch when | click inside an area is not the one | want.

The pictures used should have well differentiated color areas, which may be solid or stippled, to fill easily. Clipart
is excellent for this purpose. If there is a gap where the same color flows into another area, the fill will not work. If
Color Tolerance is switched off then switch it on in Screen Preferences. Color Tolerance will then allow you to
preview the border, which should reveal any problems with color areas in the picture. You can then alter the
picture in a picture editor such as Preview. Alternatively, use the Freehand or Precise Border functions to place
the border.

TC085 | am trying to change colors for some objects but they don’t appear on the
color worksheet in the Edit window of the Control Panel.

Colors for multicolor gradient density may only be edited by selecting the pattern fill area and changing its
properties. Similarly, the border color for a fill plus border area is on the line tab in the properties box.

TCco86 | have inserted a new point and moved an outline but there is still an
outline in the old position.

Some functions in the Create toolbars create more than one outline at a time, such as Double and Quadruple
Trace. For example, Quadruple Trace puts lines of triple and running stitches directly on top of each other. This
means that if you want to add and move a new point to change a Quadruple Trace then you will have to do so
twice, once for each of the lines. This could also happen if you used Break Apart on a fill area with border, and
then moved one of its points.

TC087 | have pasted a block but it is not the original color.

A color change is only copied when it is part of the selected block. If you paste a block that does not start with a
color change then it will use the color that is active at the point where the block is pasted. If you want to preserve
the color, either copy the relevant color change or use the FilmStrip to insert the desired color.

TCc088 All of my design turned blue when | used Paste into New Window.

Color changes are only transferred if they are within the copied block. If there are no Color changes in a pasted
block then all the objects will use the initial thread color for a new deaign, which is blue.

TC089 | did not select all the objects | wanted with Box, Freehand Point or
Freehand Select."

Objects must be fully enclosed by the selection line to be selected as part of a block. If even the smallest part of
an object is outside the line then it will not be selected.

TC090 | have created a satin border with Satin Trace but | can't change the width
of it all at once.

Use the FilmStrip, slider bars and Filters to hide all objects except the satin lines and traveling running stitch used
to create the trace. Select any satin line object in the trace, then Control—click in the FilmStrip and select Global
Properties. The properties dialog for Satin Line appears. Make adjustments as desired and click OK. The new
properties are applied to all visible satin lines.



TC091 Color Tolerance does not show me all the lines that will be traced by a
QuickTrace function.

The hatched shading used by Color Tolerance may not show on thin lines that are selected by Color Tolerance.
Simply try the QuickTrace function and if the result is not satisfactory then Undo the result and retry the trace with
a higher Color Tolerance value.

TC092 There is no underlay under a fill area.

This will happen when you select Gradient or Multi-Gradient Density for a pattern fill area. Underlay stitches are
only generated for fill areas with Normal Density selected. This is because the underlay stitching will spoil the
effect of Gradient or Multi-Gradient Density.

TC093 How do | change the border color for a fill area?

The border forms part of a fill area. To change the color of a fill area border, do as follows:

. Select a fill area with a border.

. Control—click the fill area and choose Properties from the context menu.

. Click the Line tab.

. Select Insert Color Change, then click Color Selection .

. In the Color Selection dialog select a new thread color for the border.

. Click OK twice to close the Color Selection dialog and the Properties dialog. The fill now has a differently
colored border.
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TC094 How are trims and ties added to my design?

When you export your design as an embroidery, trims and ties are automatically added between objects.

TC095 The data is from an incompatible version.

The design outline file was created by a later version of PREMIER+™ 2 Create, or is corrupt. Refer to source of
this file for a solution.

TC096 Some incompatible data was lost.

The design outline file was created by a later version of PREMIER+™ 2 Create, or is corrupt. The design may
behave unpredictably. Refer to source of this file for a solution.

Tc097 The data is not in the correct format.

The design outline file was created by a later version of PREMIER+™ 2 Create, or is corrupt. Refer to source of
this file for a solution.

TC098 Insert Design Error. Failed to load the supplied EDO file.

This message appears if an .edo file cannot be inserted. For example, it might have the extension .edo, yet not be
a proper design outline file.

TC099 Trace Failed. Maybe the image is too thick?



This happens when you use one of the Trace tools (Double Trace, Quadruple Trace, Satin Line Trace or Motif
Line Trace) to follow an outline in the picture and then Trace finds a part of the outline that is very thick. This can
be caused by excessively broad outlines or by selecting too much of the picture with a high Color Tolerance value.
In this case, Trace does not know where to trace the outline as the problem part of the outline is more like a fill
area. Use a lower Color Tolerance value, or change the picture in a picture editor to make the outline thinner or
break up the outline so that the wide parts are isolated from the rest of the outline.

TCc100 The start and end points do not line up; add a stitch or rotate?

This message may appear when exporting a running stitch design as a motif, or as a Machine Stitch. Motifs and
machine stitches are usually designed to stitch from left to right, and to start and finish at the same level. This
function allows you to add a stitch, or rotate the design, to ensure the start and end points line up.

TC101 Delete this motif, are you sure?

This message will appear if you click Delete in the My Motifs part of the Motif window. These are motifs that you
created. If you do not want to delete the selected motif, click No.

Note: The Delete button is dimmed when system motifs are used, or if only one motif is present in My Motifs.

TC102 Machine Stitch. Only Running Stitch lines can be used to create a
machine stitch. Please change your selection or convert objects to Running Line.

This message appears if you try to Export or Send a design as a machine stitch if it contains any stitch type other
than running stitch, or no stitches at all. Only use running stitch when creating machine stitches.

TC103 Error Adding Maotif. Only Running Stitch lines can be used to create a
motif. Please change your selection or convert objects to Running Line.

This message appears if you try to create a motif from a design if it contains any stitch type other than running
stitch, or no stitches at all. Only use running stitch when creating motifs.

TCc104 Error Saving Spx. Unable to open the spx file for writing.

This message appears if, for instance, you try to save a machine stitch to a read only medium such as a CD-R. A
CD-R is read only, therefore you will not be able to save the design.

TC105 XX.spx already exists. Do you want to replace it?

This message appears if a machine stitch you are trying to Save has a name that has already been used.
Replace the existing stitch, or choose a new name before saving.

Tc106 Failed to create stitch data.

This message appears if you try to Export a design as a machine stitch and the stitch cannot be created. Check
that your design consists of only running stitch lines.

Tc107 Failed to save stitch file.

This message appears if you try to Export a design as a machine stitch and the stitch cannot be saved. Check
that your design consists of only running stitch lines, and try saving the stitch under a different name in a different
place.



TCc108 The value ' is invalid. Please provide a valid value.

This message appears in the following circumstances:

« If the Density for Satin Line is below 2mm or above 15mm, or is not a number.
« If the Density for Satin Area, Satin Column, MultiWave Fill, Shape Fill, Radial Fill, Spiral Fill or Pattern Fill is
not a number.

TC109 The value * is too large. Please provide a valid value.

This message appears in the following circumstances:

« If the value entered in the Compensation box in the Satin Column, Satin Area or Pattern Fill dialog is
greater than 30.

« If the value entered in the Angle box in the Pattern Fill, Crosshatch Fill, Curved Crosshatch Fill or Motif Fill
dialog is greater than 360°.

« If the value entered in the Density box in the Satin Area, Satin Column, Pattern Fill, MultiWave Fill, Shape
Fill, Radial Fill or Spiral Fill dialog is greater than 40.

« If the value entered in the Echo Lines box in Echo Fill is greater than 30.

« If the value entered in the Horizontal or Vertical Gap box in the Motif Fill dialog is greater than 100%.

« If the value entered in the Horizontal or Vertical Offset box in the Motif Fill dialog is greater than 50%.

TC110 The value * is too small. Please provide a valid value.

This message appears in the following circumstances:

« If the value entered in the Compensation box in the Satin Column, Satin Area or Pattern Fill dialog is
smaller than 0.

« If the value entered in the Angle box in the Pattern Fill, Crosshatch Fill, Curved Crosshatch Fill or Motif Fill
dialog is smaller than 0°.

« If the value entered in the Density box in the Satin Column, Satin Area, Pattern Fill, MultiWave Fill, Shape
Fill, Radial Fill or Spiral Fill dialog is smaller than 2.

« If the value entered in the Echo Lines box in Echo Fill is smaller than 1.

« If the value entered in the Horizontal or Vertical Gap box in the Motif Fill dialog is smaller than -50%.

« If the value entered in the Horizontal or Vertical Offset box in the Motif Fill dialog is smaller than -50%.

TC111 The value *mm’ needs to be in the range 0.0 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Minimum Gap box in the Motif Line dialog, or the Motif section of
the Multiwave Fill or Shape Fill dialog is below Omm or above 20mm.

TC113 The value *mm’ needs to be in the range 0.2 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the Contour Fill dialog is below 0.2mm or above
5mm, or is not a number.

TC115 The value *mm’ needs to be in the range 1 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the QuiltStipple Fill dialog is below 1mm or above
5mm, or is not a number.



TC117 The value *mm’ needs to be in the range 1 to 12 mm. Please provide a
valid value.

This message appears if the size entered in the Width box in the Satin Line dialog is below 1mm or above 12mm,
or is not a number.

TC118 The value *mm’ needs to be in the range 1 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Stitch Length box in the Motif Line dialog, or the Spacing box in
Echo Fill is below 1mm or above 20mm, or is not a number.

TC119 The value *mm’ needs to be in the range 2 to 20 mm. Please provide a
valid value.

This message appears if the size entered in the Spacing box in the Crosshatch Fill or Curved Crosshatch Fill
dialog is below 2mm or above 20mm, or is not a number.

Tc120 This character is not in the font. Please enter a valid character.

This message appears if the character selected is not in the font. Such characters include square brackets [] and
braces {}. Select a valid character from the popup menu.

TC122 The value "mm’ needs to be in the range 3 to 200 mm. Please provide a
valid value.

This message appears if the size entered in the Size box in the Insert Lettter dialog is below 3mm or above
200mm, or is not a number. The Size setting refers to the height in millimeters of an uppercase 'A' in the selected
font. If you wish to increase letter above this you could click and drag one of the corner boxes to resize of rescale
it.

TCc123 Could not create new document for 'Paste into New Window'

This message appears if the object pasted from the Clipboard is not stitch data. It may be from another app.
Make the selection again, then copy and paste it.

Tc124 The document XX could not be saved. No stitch data to save.

This message appears if there are no stitches in your embroidery design. For instance, if you deleted the
embroidery and then tried to save it.

TC125 XX.edo already exists. Do you want to replace it?

This happens when you are doing a Save on an .edo design outline file and you have given the name of a file that
is already there. Click Cancel or Replace as appropriate.

TCc126 Only Running Stitch lines can be used to create a machine stitch. Please
change your selection or convert objects to Running Line.

This message appears if you try to Export or Send a design as a machine stitch if it contains any stitch type other
than running stitch, or no stitches at all. Only use running stitch when creating machine stitches.



TC127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE 3 Embroidery System as a result of upgrading to the latest
Mac OS Update

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True 3 Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery 3 Software section, download the latest TruEmbroidery3Software32.pkg file.

. Close down all TruEmbroidery 3 System Apps.

. Install the TruEmbroidery3Software32.pkg file that you just downloaded.

. Open TruE 3 Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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TC129 Delete My Fill: Are you sure you want to delect the selected pattern? This
action cannot be undone.

This message appears when you delete a My Fill pattern from the Manage My Fills dialog. Click Yes or No, as
desired.

TCc130 Import Failed: Cannot load picture XX. The width and height must be
between 120 and 700 pixels.

This message appears when you import a picture for a My Fill, but the picture is too large. Click OK to close the
message, and resize the picture in a picture editor before trying again.

TC131 Unable to Export My Fill image.

This message appears when you try to Export a My Fill picture, but the picture cannot be exported. For example,
if you tried to save it to a CD-R. Click OK to close the message, and choose another place to save the picture
before trying again.

TQoo1 How do | delete fonts that | have created in PREMIER+™ 2 QuickFont?

You can do this using the Font Manager in PREMIER+™ 2 Embroidery.

1. Open PREMIER+™ 2 Embroidery.

2. In the Letter window click Font Manager.

3. Choose the Category for the font (this will usually be MyFonts).
4. Select the font.

5. Click the Delete button.

6. Click Yes to the removal message.

The font is removed from its font category.

TQ002 How do | create my own fonts in the PREMIER+™ 2 software?

This can be achieved using PREMIER+™ 2 QuickFont.

Open PREMIER+™ 2 QuickFont from the Launchpad or via the Letter tab of the PREMIER+™ 2 Embroidery
Control Panel.



PREMIER+ 2 Cross Stitcher

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

cco10 When upgrading my Mac® operating system, my activation was lost.
What should | do?

Update the Applications in your PREMIER+™ 2 Embroidery System to the latest version. Then, in PREMIER+™
2 Configure select Activate and reactivate using your current Activation Code.

Before PREMIER+™ 2 Mac Applications 12.1.1, an activation could be broken when macOS was updated. This is
resolved in version 12.1.1.

We strongly recommend that after you update to 12.1.1 from 12.0 or 12.1, you run Activate again in PREMIER+™
2 Configure using your current Activation Code, to move to the new activation method.

Note: This updates your current activation, it does not use a new activation.

cso007 Error: "This will remove all stitches of this color. Do you wish to continue?"

This message appears when you select a color in the Color Select area and click Delete, if there are stitches
using the selected color in the cross stitch design. Click OK to continue, for example, to remove a color that is
only used in the background.

cso008 | have changed grid color and spacing and now | wish to return to the
original settings
Use PREMIER+™ 2 Configure to change the grid color. Click the Color block and the Colors window appears to

allow you to choose a color. The color set by default for your PREMIER+™ 2 Software is 127, 127, 127 (RGB).
You can use the RGB Sliders in the Colors Sliders tab to return to this color.

To set the Grid to 5 lines (the default setting), choose View > Grid > Every 5 lines.

cso009 | have used a variegated thread, but it is only showing as a single color

Only the first color in a variegated thread is shown in a cross stitch design. To see the effect of a variegated
thread, use Design Player or Life View.

cso010 | have placed backstitch, but it is not visible at all zoom levels

If the grid color is similar to the color of backstitch, then the backstitch may blend with the grid at certain zoom
levels so that it is hard to see. Turn off the grid temporarily to see where you have placed your backstitch.
Backstitch may also be easier to see in Block mode.

cso011  Stitches seem to be missing when | open my cross stitch designs after |
have been working for a while

This will only happen if you have used Hide Colors to hide some of the colors or stitches in a design you were
working on previously. The Hide Colors options are not reset automatically until you restart PREMIER+™ 2 Cross
Stitcher. Click the Hide Colors icon, then click Reset.

Ccso012 | have loaded a picture for a new design, but Flood Fill covers the whole
picture when | try to fill colored areas of the picture



Neither Flood Fill not Pattern Flood Fill are not affected by areas of color in a background picture. An empty area
of the design can be flood filled until it meets existing crosses and backstitch. A connected area of the same
colored crosses can be flood filled until it meets an empty area, backstitch or crosses in a different color. To
clearly see the areas that will be flood filled, turn off the background picture.

cs013 Flood Fill does not fill the whole area as expected

In some cases, the fill will not go through narrow areas. If the fill could not continuously connect a fill of full
crosses through a narrow gap, the gap will act as a barrier to flood fill.

CS014 | have a pattern that uses freehand backstitch. When | use it to fill an area
it does not seem to fill the area completely or some lines of freehand backstitch
appear to be missing.

When a pattern is used to fill an area, freehand backstitch in the pattern will only be placed when both end points
lie within the fill area. Long sections of freehand backstitch are less likely to have both ends in the fill area and
may not give the desired result. If you wish to use freehand backstitch in a pattern, try to use short sections where
possible.

cso15 When | use Rotate 90 on a selection, the selection becomes a square

The selection area is extended by Rotate 90 so that you can clearly see where the selection will be placed by
each click of the Rotate 90 icon. The stitches in the selection area are not changed.

cso016 Nothing seems to happen sometimes when | use Undo after using Erase

Each time you click with Erase, this is recorded as an action you can Undo. If you click in blank space, or you
miss the item you are trying to Erase, the action is still recorded for Undo. Hence, when you Undo, the Erase
action is undone, even though it seemed to have no effect on the design.

cs017 The embroidery is larger than the design size | selected in the Cross
Stitch Design Assistant or Design Properties

This may happen if you have French knots on the edges of your design. French knots are drawn by placing their
center point on any point that snaps to half grid spacing. Therefore, if they are placed along the edges of the
design, half of each French knot is outside the grid. If French knots are placed on all edges of the grid, the
resulting embroidery is larger than the design by the size of a French knot.

Note: French knots are only scaled in comparison to the full cross size when the Cross Size in Design Properties
is set between 2mm and 4mm. The French knots will not be any smaller or larger than they are at these limits.

Ccs018 The embroidery seems to have too many stitches

Check the Design Properties dialog to ensure you do not have a large number of strands for crosses and/or
backstitch in the design. Increasing the number of strands will increase the number of stitches.

Ccs019 The embroidery is very thick when it stitches out

Check the Design Properties dialog to ensure you do not have a large number of strands for crosses and/or
backstitch in the design. Increasing the number of strands will increase the density of stitches.

Ccs020 There seem to be some very thick lines of stitching where | used
backstitch in the design



Standard Backstitch and Freehand Backstitch are drawn on two separate layers in PREMIER+™ 2 Cross
Stitcher, but they are stitched out together if they are the same color. In addition to this, Freehand Backstitch can
be placed in multiple layers over the same line, as long as the end points of each line are different.

This is used, for example, to place different colors of Freehand Backstitch on top of each other to secure the
edges of lace. Each layer will stitch out separately according to the color order in the design, but the same thread
color is used in the stitchout to give a single color to the lace effect.

GA005 Error "Feature not available in this version."

This message appears when trying to start a module or feature if the PREMIER+™ 2 Embroidery System cannot
detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use PREMIER+™ 2 Configure to change screen background color. Click the Color block and the Colors window
appears to allow you to choose a color. The color set by default for your PREMIER+™ 2 Embroidery System is
211, 233, 255 (RGB). You can use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in PREMIER+™ 2 Configure to return the toolbar and windows in the app to their default
settings.

To return the buttons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the
default button set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System apps that are open.

2. Click the PREMIER+™ 2 Configure icon in the Launchpad, or double-click the PREMIER+™ 2 Configure
icon in the Finder.

. Click the Utilities tab.

. Click Reset All Apps.

. Click the Quit Open PREMIER+™ 2 Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some PREMIER+™ 2 apps are still open, a message appears, saying that some apps appear to be
running. Click OK to close all running PREMIER+™ 2 apps, or click Cancel.
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The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE023 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Export has a name that has already been used. Replace
the existing embroidery, or choose a new name before exporting.

GE024 Exporting to XX failed. The design was too big for the export format.

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.



GE050 Error: "Exporting to XX failed."

This message appears if, for instance, you attempt to save the design to a CD. A CD-ROM is read only, therefore
you will not be able to save the design.

PREMIER+ 2 Embroidery

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

ccoo1 Warning. Some PREMIER+ 2 apps still appear to be running. Do you
really want to reset all modules?

This message is displayed if you select Reset All Apps in the Utilities tab while other PREMIER+™ 2 Software
apps are running. Click Cancel, or use Quit Open PREMIER+ 2 Apps to close all open apps.

ccoo8 How do | activate my software?

You can activate your software when installing. Alternatively, select the Register button in PREMIER+™ 2
Configure at any time to activate. Once you have activated, your activation code is in your registration entry.

ccoo9 How can | move my activation to another computer?

You can move your activation to another computer.

In the Utilities page of PREMIER+™ 2 Configure click the Activate button and sign in to your Registration
account.

1. On the Enter Your Product Activation Codes page click 'l would like to remove my Activation from this
computer'.

2. Click OK to remove the activation from the computer.

You will then be able to install and activate your software on another computer.
Your activation code is in your registration entry.

cco10 When upgrading my Mac® operating system, my activation was lost.
What should | do?

Update the Applications in your PREMIER+™ 2 Embroidery System to the latest version. Then, in PREMIER+™
2 Configure select Activate and reactivate using your current Activation Code.

Before PREMIER+™ 2 Mac Applications 12.1.1, an activation could be broken when macOS was updated. This is
resolved in version 12.1.1.

We strongly recommend that after you update to 12.1.1 from 12.0 or 12.1, you run Activate again in PREMIER+™
2 Configure using your current Activation Code, to move to the new activation method.

Note: This updates your current activation, it does not use a new activation.

cco11 Why does my Mac® show PREMIER+™ 2 Embroidery Free?

Your Mac® will show PREMIER+™ 2 Embroidery Free if you do not have a license for the PREMIER+™ 2
Embroidery System, or if your activation has become corrupted.

If you are using PREMIER+™ 2 Embroidery Free, you do not need to do anything.

To activate or repair your installation, install the latest version of Applications for your PREMIER+™ 2 Embroidery
System. In PREMIER+™ 2 Configure select Activate and activate using your Activation Code.



Note: Repairing an existing activation will not use up a second activation.

EC003 Can | set the PREMIER+™ 2 Machine app to start automatically when |
turn on my computer?

Yes, you can by using the following instructions:

. Click on System Preferences from your Dock - the icon that looks like a cog.

. In the System area, click on Users & Groups.

. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right pane of that window.

. Click on the + icon on the right pane of that window. An Open dialog will appear.

. On the left pane - under the Favorites section; click on the Applications entry.

. In the right pane, scroll down the list of apps until you come to the PREMIER+™ 2 Machine entry.

. Select the PREMIER+™ 2 Machine entry and click on the Add button.

. You will now see PREMIER+™ 2 Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.

WN =

O©ooO~NO O~

When you next log into your computer; the PREMIER+™ 2 Machine app will run automatically.

EC004 Can | connect more than one embroidery machine to my computer with
PREMIER+™ 2 Machine?

No, you are not able to connect two embroidery machines at the same time, and to send a design to the first
embroidery machine and then to the second embroidery machine.

If you want to send an embroidery to two machines, do as follows

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the PREMIER+™ 2 Machine app is running. PREMIER+™ 2 Machine appears as a machine
icon in the menu bar.

If PREMIER+™ 2 Machine is not running, start it.

» Click the PREMIER+™ 2 Machine icon in the Launchpad, or double-click the PREMIER+™ 2 Machine icon
in the Finder.

Second, confirm that the PREMIER+™ 2 Machine app is communicating with your embroidery machine.

o Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start PREMIER+™ 2 Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart PREMIER+™ 2 Machine.

EC006 | sent a design to my embroidery machine, but nothing happened.

You can only send a design directly to your embroidery machine if the following folder exists:
ILibrary/Application Support/VsmSoftware/Premier+2/TempSend.
If this folder does not exist, do as follows:

1. Open a Finder window.
2. In the Go menu, hold down the Option key and choose Library.
3. Browse to Application Support/VsmSoftware/Premier+2.



4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

Now try to send the design again.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMBS folder, while for the MC11000 and MC 12000 they must
be placed in the Embf folder.

GA002 Error: "Exporting to XX failed. The design was too big for the export
format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Feature not available in this version."

This message appears when trying to start a module or feature if the PREMIER+™ 2 Embroidery System cannot
detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE001 | cannot open Melco (.exp) files in the PREMIER+™ 2 Embroidery
software.

The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert to use those designs in your PREMIER+™ 2 Embroidery System software.



GE002 Some of the items in a menu are dimmed.

Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."

Use PREMIER+™ 2 Configure to change the grid color. Click the Color block and the Colors window appears to
allow you to choose a color. The color set by default for your PREMIER+™ 2 Software is 127, 127, 127 (RGB).
You can use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use PREMIER+™ 2 Configure to change screen background color. Click the Color block and the Colors window
appears to allow you to choose a color. The color set by default for your PREMIER+™ 2 Embroidery System is
211, 233, 255 (RGB). You can use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in PREMIER+™ 2 Configure to return the toolbar and windows in the app to their default
settings.

To return the buttons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the
default button set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System apps that are open.

2. Click the PREMIER+™ 2 Configure icon in the Launchpad, or double-click the PREMIER+™ 2 Configure
icon in the Finder.

. Click the Utilities tab.

. Click Reset All Apps.

. Click the Quit Open PREMIER+™ 2 Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some PREMIER+™ 2 apps are still open, a message appears, saying that some apps appear to be
running. Click OK to close all running PREMIER+™ 2 apps, or click Cancel.
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The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE007 When | try to use the number box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired
thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.



The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color is replaced with the nearest match in the Import
Thread Range you have set in PREMIER+™ 2 Configure. You can alter it to any other color if desired. To check
for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GE009 \When | open a picture the name is displayed, but | cannot see the picture
and Continue is dimmed.

This can happen if the desired picture is corrupt. For example, it might have an extension such as .bmp or .jpg,
yet not be a proper picture file.

GE012 The file XX is locked. If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy, click Duplicate.

This message appears when trying to edit an embroidery design outline which is locked, or is on a read-only
medium such as a CD-R. Unlock the embroidery design outline before editing, or duplicate it and then edit it, if it
is on a read-only medium.

GE013 The file XX is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery design outline which is on a read-only medium such
as a CD-R. Duplicate it, then edit and save it.

GE014 The file doesn’t exist.

This message appears if the desired design is not where the app expects it to be, for example if a design was
saved to a network drive, then deleted or renamed.

The message would appear if you tried to load the design from the Open Recent list on the File menu.

GE015 Unrecognized file format.

This message appears if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE016 Unrecognized file extension.

This message may appear if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE017 Background Image Warning. This will remove your existing image,
continue?

This message appears if you try to load a background image when an image has already been loaded. Click OK
to load a new image, or Cancel to use your existing image.

GE018 Background Image Error. Could not open the background image.

This message appears if you try to load a background image and the picture is corrupt. For example, it might
have an extension such as .bmp or .jpg, yet not be a proper picture file.



GE019 The document XX could not be saved as XX. The volume is read only. Try
saving the file to another volume.

This message appears if, for instance, you try to save an embroidery design to a CD-R. A CD-R is read only,
therefore you will not be able to save the embroidery design. Save the embroidery design to another medium .

GE020 The document XX could not be autosaved. The volume is read only. Try
saving the file to another volume. You can also duplicate the document or discard
your changes to close it.

This message appears if, for instance, you have loaded an embroidery design from a CD-R and then attempt to
save the embroidery design back to the CD. A CD-R is read only, therefore you will not be able to save the
embroidery design. Save the embroidery design to another medium .

GE021 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Save has a name that has already been used. Replace
the existing embroidery, or choose a new name before saving.

GE022 Embroidery is too large or will not fit in hoop.

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you choose Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again. Alternatively, change the size
of the hoop.

GE023 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Export has a name that has already been used. Replace
the existing embroidery, or choose a new name before exporting.

GE024 Exporting to XX failed. The design was too big for the export format.

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GE025 Print. Embroidery is too large or will not fit in hoop.

This message appears if the embroidery on screen is partially outside the selected hoop. Move the embroidery
completely within the four blue corners of the work area and try again, or change the hoop size

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE027 Not For Sale. This is a Dealer version of the PREMIER+™ 2 Embroidery
System and not for retail sale. If you are not a certified registered PREMIER+™ 2



Embroidery System dealer you are not entitled to use this software. Please
contact your local dealer for further information.

This message means that the app is a dealer only version for demonstration and training purposes, and is not
available for retail sale. Please contact software support for further information.

GE028 Could not understand the string XX.

This message appears if the value entered in a number box is outside the valid range, or is not a number.

GE029 The file doesn’t exist.

This message appears if the desired embroidery is not where the app expects it to be, for example if an
embroidery was saved to a network drive, then deleted or renamed. The message would appear if you tried to
load the embroidery from the Open Recent list on the File menu.

GE030 Unrecognized file format.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqvarna Viking/Pfaff embroidery.

GE031 Not enough memory available to perform function.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqvarna Viking/Pfaff embroidery.

GE032 Cannot open stitch file.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husgvarna Viking/Pfaff embroidery.

GE033 Unrecognized file extension.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqvarna Viking/Pfaff embroidery

GE034 Stitch file is corrupt.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE035 Stitch file XY coordinates incorrect.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE036 The document "xx" could not be opened.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE037 The file "xx" is locked. If you want to make changes to this document,
click Unlock. To keep the file unchanged and work with a copy, click Duplicate



This message appears when trying to edit an embroidery which is locked, or is on a read-only medium such as a
CD-R. Unlock the embroidery before editing, or duplicate it, and then edit it, if it is on a read-only medium

GE038 The file "xx" is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery which is on a readonly medium such as a CD-R.
Duplicate it, then edit and save it.

GE039 Information About Colors in PREMIER+™ 2 Embroidery System Files

The PREMIER+™ 2 Embroidery System will display threads in a file in the same way on any computer where it is
installed. That is, the colors used will be the same even if they are reproduced slightly differently on different
monitors. You can print a worksheet to see the colors and color names used in a particular design. This is true,
even if you do not have all the threads in a design defined in the database on your computer. This is because a
PREMIER+™ 2 Embroidery System design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

o Athread from the Thread Database.

« Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the PREMIER+™ 2 Embroidery System
where you can change colors, as follows:

» Editing apps: PREMIER+™ 2 Embroidery and PREMIER+™ 2 Modify
» Design apps: PREMIER+™ 2 Create

» Adding/Editing Thread: PREMIER+™ 2 Thread Cache

» Generating fonts: PREMIER+™ 2 QuickFont

In GE040 and GE041 are some situations you may encounter according to the availability of thread definitions, as
categorized above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

GE041 | have a vp4 or vp3 embroidery from another user that uses a custom
thread definition they designed.

If you attempt to change the color the nearest match will be selected. If desired, select a replacement thread.

GE042 Do you want to remove all points from your demo? This cannot be
undone.

This message appears if you use Reset My Demo in Life View. Click Yes to continue, or No to keep your existing
My Demo.

GE043 How do | backup a My Demo animation?

The My Demo animated preview is stored in the AnimationPath.txt file in the folder
/User]/Library/ApplicationSupport/VSMSoftware/Premier+2/System. This location may not be visible on your
Mac®, but you can find it using the following steps.



To Backup a My Demo Animation

1. Open the Finder window.

2. Open the Go menu.

3. Hold down the Option (Alt) key, and choose Library.

4. Browse to /ApplicationSupport/VSMSoftware/Premier+2/System.
5. Copy the file AnimationPath.txt to your backup location.

| recently captured an image using a camera in a PREMIER+™ 2 Assistant.

Images that have recently been captured using your webcam in one of our PREMIER+™ 2 Assistants can be
found in /User]/Library/Containers/com.apple.ImageKit.RecentPictureService/Data/Library/Images/Recent
Pictures. This location may not be visible on your Mac®, but you can find it using the following steps.

To Manage Recent Pictures Taken By Your Webcam

. Open the Finder window.

. Open the Go menu.

. Hold down the Option (Alt) key, and choose Library.

. Browse to
/User]/Library/Containers/com.apple.ImageKit.RecentPictureService/Data/Library/Images/Recent
Pictures.

. Open the View menu in Finder.

. Click on the as Icons option to have a better view of the individual images.

. Manage the .png or .tiff files in that folder as needed.
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The process of exporting SHV designs to a USB Embroidery stick may take up to a few minutes.

When the 'Exporting to USB Stick' progress bar disappears; then the designs have written to the USB Embroidery
Stick.

Be sure to go to Finder and Eject your USB Stick before removing it from the computer and inserting it into your
Designer 1 USB machine.

It may be that your USB Embroidery Stick is running very low on space.

It is advisable to format your USB Embroidery Stick to ensure that it has enough space for your SHV designs to
be written.

The following formatting process will delete ALL files/folders from your USB Embroidery Stick. If you have any
files/folders that you wanted to keep, then backup them up before proceeding with the following procedure.

. Eject and then remove all USB Sticks/Hard Disk from your Mac®.

. Insert your USB Embroidery Stick that you would like to format.

. Open Finder.

. Click on the Go menu.

. Click on the Home option.

. Browse to .../Premier+2/Samples/Finder/Stitch/Animals

. Control+click on any .vp3 or .vp4 file shown. A context menu will appear.

. Move your mouse to the Services sub-menu

. Click on the Premier+ 2 Convert option. APREMIER+™ 2 Convert box should appear.
10. Click on the ... button in the Output File Type section.

11. Select Husqvarna Viking Designer 1 (.shv) from the list.

12. Click on the USB Stick button in the Select Device section

13. Click on the Format button in that section. A warning will appear.

14. After you have read and accepted the warning, click Yes to start the Formatting process.
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15. The formatting process should take less than a minute.
16. When it is complete, try to export your SHV designs again to the USB Embroidery Stick.

GE047 How do | change the measurement in the PREMIER+™ 2 software?

The measurements are taken from the settings on the Appearance tab in PREMIER+™ 2 Configure.
To change those settings, do the following:

1. Go to the Launchpad.

2. Open PREMIER+™ 2 Configure.

3. Click on the Appearance tab.

4. From the Show Measurements In: section, either choose Millimeters (mm) or Inches (“).

GE048 | have a Husqvarna Viking Designer | machine; how do | create a SHV
design?
You would need to choose Husqvarna Viking Designer | from the Export dialog:

1. Click on the File menu

2. Choose Export.

3. Select Husqvarna Viking Designer | (.shv) from the drop-down list.

4. Depending on which device (floppy disk or USB Embroidery Stick) you are write to, you will click on the
appropriate icon for that device.

5. [Optional] to backup the items already on your floppy disk/lUSB Embroidery Stick; click on the Read
Stick or Disk button and then choose the location to save your backup to.

6. Click on the Next button to start writing to that device.

N.B. The instructions above are only applicable to PREMIER+™ 2 EMBROIDERY, PREMIER+™ 2 EXTRA or
PREMIER+™ 2 ULTRA owners with activated software.

GE049 | cannot see all my PREMIER+™ 2 icons in Launchpad.

Launchpad shows the icons for all your installed software on your Mac® computer.

Depending on how many apps you have installed on your Mac®; the icons may span more than one page in
Launchpad .

When there is more than one page of icons available in Launchpad , there will be a number of ‘dots’ —
representing all the available Launchpad pages. The dot for the current page will be highlighted, click on one of
the other dots to navigate between pages.

GE050 Error: "Exporting to XX failed."

This message appears if, for instance, you attempt to save the design to a CD. A CD-ROM is read only, therefore
you will not be able to save the design.

GE051 Error: The value '* is invalid. Please provide a valid value.

This message appears if the number entered is above or below the permitted range, or a character other than a
number was used.

GE052 Error: The value * is too small. Please provide a valid value.

This message appears if the number entered was smaller than the permitted minimum.

GE053 Error: The value * is too large. Please provide a valid value.



This message appears if the number entered was larger than the permitted maximum.

GE054 Error: The value "mm’ needs to be in the range XX to YY mm. Please
provide a valid value.

This message appears if the value entered in the number box is below the permitted minimum or above the
permitted maximum.

IN001 This package will run a program to determine if the software can be
Installed.
This message appears when installing the Samples or Bonus Designs. Click Continue to proceed with the

installation if the software has already been activated. Otherwise, activate your software, and then install the
Samples or Bonus Designs.

IN021 Where are my samples/backgrounds/documents/bonus designs?

When installing any of the PREMIER+™ 2 Embroidery System samples/backgrounds/documents/bonus designs
the files should be installed in subfolders of the folder /Users/Home/Premier+2/ (where Home means the account
of the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

IN022 Backgrounds / Bonus Design installs: "The installation failed. The installer
encountered an error..."

When installing the Backgrounds or Bonus Designs installs, you may receive the "The installation failed. The
installer encountered an error..." message.

This is because your Premier+2/Samples folder can only be read - it is not possible to create files or folders
within the Samples folder.

To resolve this issue download and install all the available Smart Update files:

1. Open PREMIER+™ 2 Configure.
2. Click on the Smart Update button.
3. Follow the on-screen instructions to download and install all the available updates.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.

If you are not at the computer with PREMIER+™ 2 Embroidery, you can enter your e-mail address and password
to find your registration details.

sT004 ColorSort does not work for the multi-color monogram that | created

When creating multi-color lettering, ensure that the Trim Connection is selected. If Running Connection is
selected, you will not be able to ColorSort the lettering.



sT006 When | ColorSort an embroidery the number of color blocks produced
varies

The ColorSort process does not just put the same color blocks together. It checks for overlap between areas,
therefore depending on the overlaps, the final number of color blocks may vary, even if you are Combining a
similar number of SuperDesigns or monograms.

sT011 Error: "Embroidery is too large or not in the hoop"

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again.

SsT012 Error: "Embroidery is too large or will not fit in hoop" when printing

This error can occur when an embroidery design(s) are partially outside of the hoop area when you try to print.
Move the design(s) so that they are entirely within the hoop area; or alternatively use a larger hoop.

sT018 The embroidery | want to work with appears too small on the screen

Make sure the PREMIER+™ 2 Embroidery window is maximized by choosing Window > Zoom. Click Zoom To Fit
to expand the hoop so it fills the work area. Also, choose a Hoop Size in Hoop Selection that is suitable to the
embroidery size.

sT019 | find it hard to select the part of the embroidery | wish to edit

Many functions of PREMIER+™ 2 Embroidery can be used to help see sections of embroideries more easily.
They include the Zoom slider and the different methods of selection (Box Select, Freehand Select and Freehand
Point Select). Use Command and the left or right arrow (38« or 3£—) to select each embroidery in turn.

sT029 | have increased the Gap setting, but the lowercase characters are still
touching each other

For script fonts, the Gap setting has no effect on adjacent lowercase characters. Script fonts use a special
‘continuous' joining method, which places lowercase characters adjacent to each other to give the appearance of
handwriting. All the fonts in the Script category use this joining method.

sT030 All the lettering appears in uppercase, even though | have entered
lowercase characters in the Letters box

You are using an uppercase font. In an uppercase font (with UC in the name), all the lowercase characters are
identical to the uppercase characters.

ST038 | have selected the correct hoop size, but the graphical representation
does not look the same as my real hoop
This will happen if you choose a Universal Hoop that is the same size. The Universal Hoops are shown as plain

hoops of the selected size. Use Hoop Selection to choose the desired hoop size, but do not choose a Universal
Hoop.



sT043 The Mirror option does not seem to have any effect in the Encore
function.

If your embroidery is horizontally symmetrical before you use the Encore function, the Mirror option will have no
apparent effect. However, it will affect stitch order of each alternate copy. For example, clockwise stitching will
become counter-clockwise, and so on.

ST044 The value mm’ needs to be in the range 3 to 200 mm. Please provide a
valid value.

This message appears if the size entered in the Size Box on the Letter window of the Control Panel, or in the
Letter Properties dialog is below 3mm or above 200mm, or is not a number. The Size setting refers to the height
in millimeters of an uppercase 'A' in the selected font. If you wish to increase lettering above this you could drag
one of the corner boxes or alter the Height or Width proportions.

ST045 The value *mm’ needs to be in the range 1 to 5 mm. Please provide a
valid value.

This message appears if the size entered in the Line Spacing box in the Letter Options or Letter Properties dialog
is below 1mm or above 5mm, or is not a number.

ST047 The value " is invalid. Please provide a valid value.

This message appears if the value entered in the height or width box on the SuperDesign window of the Control
Panel, or in the SuperDesign Properties dialog, is not a number.

ST048 The value *mm’ needs to be in the range 5 to 200 mm. Please provide a
valid value."

This message appears if the size entered in the Size Box on the SuperDesign window of the Control Panel, or in
the SuperDesign Properties dialog, is below 5mm or above 200mm, or is not a number. The Size setting refers to
the height in millimeters of the selected SuperDesign. If you wish to increase the size above this you could drag
one of the corner boxes or alter the Height or Width proportions.

ST049 The value * is too small. Please provide a valid value.

This message appears if the value entered in the height or width box on the SuperDesign window of the Control
Panel, or in the SuperDesign Properties dialog, is smaller than 25%.

sT050 The value * is too large. Please provide a valid value.

This message appears if the value entered in the height or width box on the SuperDesign window of the Control
Panel, or in the SuperDesign Properties dialog, is greater than 400%.

sT051 The value "™ is invalid. Please provide a valid value.

This message appears if the value entered in the height or width box in the Frame Options or Frame Properties
dialog is not a number.

SsT052 The value "mm’ needs to be in the range 5 to 500 mm. Please provide a
valid value.



This message appears if the size entered in the Size Box in the Frame Options or Frame Properties dialog is
below 5mm or above 500mm, or is not a number. The Size setting refers to the height in millimeters of the
selected Frame. If you wish to increase the size above this you could click and drag one of the corner boxes or
alter the Height or Width proportions.

sT053 The value *mm’ needs to be in the range -50 to 50 mm. Please provide a
valid value

This message appears if the size entered in the Margin box on the Frame window of the Control Panel is below
-50mm or above 50mm.

ST054 The value * is too small. Please provide a valid value.

This message appears if the value entered in the height or width box in the Frame Options or Frame Properties
dialog is smaller than 25%.

ST055 The value * is too large. Please provide a valid value.

This message appears if the value entered in the height or width box in the Frame Options or Frame Properties
dialog is greater than 400%.

SsT056 The value "mm’ needs to be in the range -50 to 50 mm. Please provide a
valid value."

This message appears if the size entered in the Margin box on the Border window of the Control Panel is below
-50mm or above 50mm.

SsT067 The selected dimensions will produce a large PhotoStitch and stitch
creation may take some time. Transparent background areas will reduce the time
required.

This message will appear if you specify a PhotoStitch larger than 26000mm square. Click OK to continue creating

the PhotoStitch. To reduce the stitch creation time, use a picture editor such as Preview to remove the picture
background, particularly any very detailed areas.

sT068 | find it hard to select the embroidery | wish to edit.

Many functions of PREMIER+™ 2 Embroidery can be used to help see embroideries more easily. They include
the Zoom Commands and the different methods of selection (Box Select, Freehand Select and Freehand Point
Select). Use Command and the left or right arrow (8« or 38—) to select each embroidery in turn.

sT069 Certain functions don't seem to work all the time.

Some functions, such as the alignment tools, are only available when one or more embroideries are selected. To
use these functions, select one or more embroideries first.

sT070 I've selected the wrong embroidery to move or manipulate.

To deselect an embroidery, click the mouse outside the embroidery, or on another embroidery. To select the
desired embroidery, click on it and an outline box appears. If one embroidery or piece of lettering is overlapping
another making it difficult to select, use Command and the left or right arrow (38« or 3 —) to select each
embroidery in turn.



sT071 The Color Select area on the Design window appears blank.

If no design is selected, or more than one design is selected, the Color Select area on the Design window will be
blank. To change the threads in an embroidery, select the single embroidery, then view the threads in the Color
Select area.

sT072 | did not select all the embroideries | wanted with Box, Freehand or
Freehand Point Select.

The embroideries must be fully enclosed by the selection line to be selected as part of a block. If even the
smallest part of an embroidery is outside the line, then it will not be selected.

sT073 | want to change the design that has been used in the corners in Encore.

In Encore Shape and Encore Hoop, when two embroideries are selected, the embroidery that is first in the
stitchout order will be placed in the corners. If you want to use the other embroidery in the corners, use Layout
Order to change the order.

sT074 Not all of my designs have been used in the Encore function.

A maximum of two designs can be used with Encore Shape and Encore Hoop. If more than two designs are
selected, only the first two that were loaded will be used in the Encore. Either use Encore Circle or Line, or
combine some of the embroideries before using Encore.

sT075 | cannot use some other functions when previewing Encored designs.

While in Preview mode it is not possible to select any other tab on the control panel, or many other functions. If
you use the design viewer, the Encore will be cancelled.

sT076 | don’'t remember which font | used when making an embroidery.

Information on the font, SuperDesign, Frame or Border used in an embroidery made in PREMIER+™ 2
Embroidery is stored in the Settings. Open the embroidery, then click the Settings tab and Edit in the Design
window to view the full text of the settings. Alternatively, print a worksheet for the embroidery.

sT077 | want to change the size of the lettering, but the control boxes have no
effect.

For the following Lettering Shapes, there are no control boxes to change the size of the characters in the lettering:

» Circle Clockwise

« Circle Clockwise

e Full Circle

» Fit To Straight Line
» Fit To Wavy Line

Instead, use Size, Height and Width in Letter Properties to change the size of the characters.

sT078 | want to change the appearance of the font stitching, but the Stitch Type
drop-down is not available.

Some fonts have non-editable properties. For example, they may use more than one pattern for satin or fill, or use
the same fill pattern at different angles in different characters. Therefore, there is no overall uniform property that
can be changed, so the properties dialog box may not be used to change the stitch Properties. You may wish to
use a different font with a similar style that allows you to change its properties.



sT079 When I try to change the stitch properties the Stitch Type pop-up menu is
dimmed (unavailable).

You are trying to change a property in a font that is not editable. For instance, if a font uses more than one type of
Pattern Fill, the stitch type will be unavailable. Also, if a font is an outline font of running, double or triple stitch, no
fill or satin properties will be available.

sT080 All the lettering appears in lowercase, even though | have entered
uppercase characters in the Letters box.

You are using an lowercase font. In a lowercase font (with LC in the name), all the uppercase characters are
identical to the lowercase characters.

sT081 | have placed multiple pieces of lettering with different text in each item
and | want to change the text that appears in some of them. However, the text in
the Letters box stays the same when | select earlier pieces of lettering.

Select the desired lettering, then Control—click the lettering and choose Properties. The Letter Properties appears
and you may change the text.

Note: Once lettering has been converted to embroidery when it is Combined or Fixed as Stitches, no adjustments
can be made with Letter Properties.

sT086 | have adjusted my lettering on the work area, but when | change the
Letter Properties, the lettering changes shape a little.

The control boxes on blocks of lettering allow subtle adjustments directly to the shape of the lettering. However,
the Letter Properties only allows the proportions of Height and Width to be adjusted. When the Letter Properties
are changed, the previous adjustments may be partially lost when the Height and Width values are applied.
Therefore, it is recommended to make all desired adjustments in Letter Properties before making final
adjustments directly with the control boxes.

sT087 In Letter Options | tried to edit the Stitch Type for my lettering, but the
pop-up menu was dimmed.

If a font does not use an editable stitch type, the Stitch Type will not be available in Letter Options

sT088 In Letter Properties | tried to edit the Stitch Type for my lettering, but there
was no pop-up menu.

Stitch types are not available in the Letter Properties dialog. Control—click the lettering, and select the stitch type
from the context menu.

sT089 | used Control—click to open the context menu for my lettering, but | could
not choose the stitch type.

If a font does not use an editable stitch type, no stitch type will be available in the context menu.



sT090 | changed a color in my embroidery, but do not like the new color. Undo is
dimmed on the Edit menu so | can't choose it.

To cancel some actions, click outside the currently active embroidery. Then choose Undo. Alternatively, Control—
click the embroidery and choose Undo from the context menu.

sT091 When | ColorSort an embroidery the number of color blocks produced
varies.

The ColorSort process does not just put the same color blocks together. It checks for overlap between areas.
Therefore depending on the overlaps, the final number of color blocks may vary, even if you have Combined
exactly the same embroideries, lettering or SuperDesigns.

SsT092 | have used a motif as an envelope border and the results are
unexpected.

If the selected motif width is larger than the size of the monogram or name, then only one motif may be created.
Adjusting lettering or motif size or spacing may allow multiple motifs to be included in the border. If the selected
motif shape is irregular it may overlap the monogram. Adjusting lettering or motif size or spacing may produce the
desired results.

sT093 How can | tell if an embroidery is already endless?

The Notes for an embroidery will have the word Endless added after any other Notes text. If the Notes have been
edited so that this is no longer the case, use the slider bars on the Modify window to see if there are marker
stitches at the beginning and end of the embroidery.

ST094 | have loaded an embroidery that | made Endless some time ago. How do
| know what Fabric Direction was used when | made it endless?

Use the slider bars on the Modify window to find the locations of the start and end marker stitches. For example, if
the start markers are at the top and the end markers are at the bottom, the original Fabric Direction was Up.

sT095 | forgot to set a Gap, but it does not appear to have worked when | tried to
make the embroidery Endless again.

This can happen if you use the Repeat Embroidery option and you do not use Undo before trying again. This is
because you have already created a repeated sequence with no gaps that then becomes a single embroidery. If
you then use the Endless Assistant again to try to add a Gap, the whole repeated sequence is treated as a single
embroidery. This should be apparent if you look at the Notes, because the word 'Endless' will occur twice at the
end of the Notes. Always use Undo to go back to the single copy of the embroidery before trying the Endless
Assistant again with different settings.

ST096 The Endless Assistant does not work.

The Endless Assistant is not available in any of the following situations:

« There is no embroidery loaded, so there is nothing that can be made endless: load an embroidery
» The embroidery is too big for or is outside the current hoop: adjust the embroidery as needed or choose a
larger hoop



sT097 Error: "A group is selected. To modify one item, use Restrict Groups and
then select the design you wish to modify."

This message is displayed if you click the Modify tab when a group is selected.

Select the item within the group that you wish to edit individually after using Restrict Groups, then click the Modify
tab again.

sT098 Error: "Multiple items are selected. Please ensure only one item is
selected."”

This message is displayed if you click the Modify tab when several items are selected. Click the individual item
that you wish to modify, or use the Tab key to step through the designs until the desired one is selected, then click
the Modify tab again.

sT099 Error: "A design must be selected to use the features of the Modify tab."

This message is displayed if you click the Modify tab when no item is selected. Select an item, then click the
Modify tab again.

sT100 Error: "This will fix your selected design as embroidery stitches. Do you
wish to continue?"

This message is displayed if you click the Modify tab when a SuperDesign, Lettering, or frame is selected. When
a design is fixed, the stitches are then created, and any further resizing may affect stitch density and length. The
stitch properties, for example the density, pattern, angle or stitch length, may not be changed after it is fixed, and
for lettering the font and text may not be changed. Only click OK if you wish that item to be fixed as stitches.

sT101 Error: "Decorations cannot be edited using the features on the Modify
tab."

This message is displayed if you click the Modify tab when decorations are selected. You cannot adjust
decorations on the Modify tab.

sT102 Error: "Pasting into the Modify tab will combine and fix as stitches all
designs from the clipboard block."

This message is displayed if you copy designs to the clipboard block, and then attempt to paste them into the
Modify tab. Only click OK if you wish the items to be fixed as stitches.

Tc124 The document XX could not be saved. No stitch data to save.

This message appears if there are no stitches in your embroidery design. For instance, if you deleted the
embroidery and then tried to save it.

TC129 Delete My Fill: Are you sure you want to delect the selected pattern? This
action cannot be undone.

This message appears when you delete a My Fill pattern from the Manage My Fills dialog. Click Yes or No, as
desired.



TC132 | would like to get rid of the lines created from the white background of my
picture by Linear PhotoStitch embroidery.

After creating and saving an embroidery, use the Edit tab or open the file in PREMIER+™ 2 Modify and use the
following instructions.

1. Use the Freehand Block Select feature to mark the stitches in the background.
2. Click Delete Stitches.
3. Save the adjusted embroidery

TQo001 How do | delete fonts that | have created in PREMIER+™ 2 QuickFont?

You can do this using the Font Manager in PREMIER+™ 2 Embroidery.

1. Open PREMIER+™ 2 Embroidery.

2. In the Letter window click Font Manager.

3. Choose the Category for the font (this will usually be MyFonts).
4. Select the font.

5. Click the Delete button.

6. Click Yes to the removal message.

The font is removed from its font category.

TQ002 How do | create my own fonts in the PREMIER+™ 2 software?

This can be achieved using PREMIER+™ 2 QuickFont.

Open PREMIER+™ 2 QuickFont from the Launchpad or via the Letter tab of the PREMIER+™ 2 Embroidery
Control Panel.

PREMIER+ 2 Modify

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

ccoo1 Warning. Some PREMIER+ 2 apps still appear to be running. Do you
really want to reset all modules?

This message is displayed if you select Reset All Apps in the Utilities tab while other PREMIER+™ 2 Software
apps are running. Click Cancel, or use Quit Open PREMIER+ 2 Apps to close all open apps.

cco10 When upgrading my Mac® operating system, my activation was lost.
What should | do?

Update the Applications in your PREMIER+™ 2 Embroidery System to the latest version. Then, in PREMIER+™
2 Configure select Activate and reactivate using your current Activation Code.

Before PREMIER+™ 2 Mac Applications 12.1.1, an activation could be broken when macOS was updated. This is
resolved in version 12.1.1.

We strongly recommend that after you update to 12.1.1 from 12.0 or 12.1, you run Activate again in PREMIER+™
2 Configure using your current Activation Code, to move to the new activation method.

Note: This updates your current activation, it does not use a new activation.



EC003 Can | set the PREMIER+™ 2 Machine app to start automatically when |
turn on my computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System area, click on Users & Groups.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right pane of that window.

. Click on the + icon on the right pane of that window. An Open dialog will appear.

. On the left pane - under the Favorites section; click on the Applications entry.

. In the right pane, scroll down the list of apps until you come to the PREMIER+™ 2 Machine entry.

. Select the PREMIER+™ 2 Machine entry and click on the Add button.

. You will now see PREMIER+™ 2 Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.

O©oo~NO O~

When you next log into your computer; the PREMIER+™ 2 Machine app will run automatically.

EC004 Can | connect more than one embroidery machine to my computer with
PREMIER+™ 2 Machine?

No, you are not able to connect two embroidery machines at the same time, and to send a design to the first
embroidery machine and then to the second embroidery machine.

If you want to send an embroidery to two machines, do as follows

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the PREMIER+™ 2 Machine app is running. PREMIER+™ 2 Machine appears as a machine
icon in the menu bar.

If PREMIER+™ 2 Machine is not running, start it.

e Click the PREMIER+™ 2 Machine icon in the Launchpad, or double-click the PREMIER+™ 2 Machine icon
in the Finder.

Second, confirm that the PREMIER+™ 2 Machine app is communicating with your embroidery machine.

» Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start PREMIER+™ 2 Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart PREMIER+™ 2 Machine.

EC006 | sent a design to my embroidery machine, but nothing happened.

You can only send a design directly to your embroidery machine if the following folder exists:
ILibrary/Application Support/VsmSoftware/Premier+2/TempSend.
If this folder does not exist, do as follows:

1. Open a Finder window.

2. In the Go menu, hold down the Option key and choose Library.

3. Browse to Application Support/VsmSoftware/Premier+2.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

Now try to send the design again.



EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMBS folder, while for the MC11000 and MC12000 they must
be placed in the Embf folder.

GA002 Error: "Exporting to XX failed. The design was too big for the export
format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"{" "2", and so on.

GA005 Error "Feature not available in this version."

This message appears when trying to start a module or feature if the PREMIER+™ 2 Embroidery System cannot
detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE001 | cannot open Melco (.exp) files in the PREMIER+™ 2 Embroidery
software.

The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert to use those designs in your PREMIER+™ 2 Embroidery System software.

GE002 Some of the items in a menu are dimmed.



Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE003 | have changed grid color and spacing and now | wish to return to the
original settings."

Use PREMIER+™ 2 Configure to change the grid color. Click the Color block and the Colors window appears to
allow you to choose a color. The color set by default for your PREMIER+™ 2 Software is 127, 127, 127 (RGB).
You can use the RGB Sliders in the Colors Sliders tab to return to this color.

Use Preferences to change the grid spacing. Set the Grid Size to 10mm.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use PREMIER+™ 2 Configure to change screen background color. Click the Color block and the Colors window
appears to allow you to choose a color. The color set by default for your PREMIER+™ 2 Embroidery System is
211, 233, 255 (RGB). You can use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in PREMIER+™ 2 Configure to return the toolbar and windows in the app to their default
settings.

To return the buttons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the
default button set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System apps that are open.

2. Click the PREMIER+™ 2 Configure icon in the Launchpad, or double-click the PREMIER+™ 2 Configure
icon in the Finder.

. Click the Utilities tab.

. Click Reset All Apps.

. Click the Quit Open PREMIER+™ 2 Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some PREMIER+™ 2 apps are still open, a message appears, saying that some apps appear to be
running. Click OK to close all running PREMIER+™ 2 apps, or click Cancel.
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The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE007 When | try to use the number box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired

thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by



someone with a later version of the thread database. The color is replaced with the nearest match in the Import
Thread Range you have set in PREMIER+™ 2 Configure. You can alter it to any other color if desired. To check
for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GE012 The file XX is locked. If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy, click Duplicate.

This message appears when trying to edit an embroidery design outline which is locked, or is on a read-only
medium such as a CD-R. Unlock the embroidery design outline before editing, or duplicate it and then edit it, if it
is on a read-only medium.

GE013 The file XX is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery design outline which is on a read-only medium such
as a CD-R. Duplicate it, then edit and save it.

GE014 The file doesn’t exist.

This message appears if the desired design is not where the app expects it to be, for example if a design was
saved to a network drive, then deleted or renamed.

The message would appear if you tried to load the design from the Open Recent list on the File menu.

GE015 Unrecognized file format.

This message appears if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE016 Unrecognized file extension.

This message may appear if the design you are attempting to load is corrupt. For example, it might have the
extension .edo, yet not be a proper design outline file.

GE017 Background Image Warning. This will remove your existing image,
continue?

This message appears if you try to load a background image when an image has already been loaded. Click OK
to load a new image, or Cancel to use your existing image.

GE018 Background Image Error. Could not open the background image.

This message appears if you try to load a background image and the picture is corrupt. For example, it might
have an extension such as .bmp or .jpg, yet not be a proper picture file.

GE019 The document XX could not be saved as XX. The volume is read only. Try
saving the file to another volume.

This message appears if, for instance, you try to save an embroidery design to a CD-R. A CD-R is read only,
therefore you will not be able to save the embroidery design. Save the embroidery design to another medium .



GE020 The document XX could not be autosaved. The volume is read only. Try
saving the file to another volume. You can also duplicate the document or discard
your changes to close it.

This message appears if, for instance, you have loaded an embroidery design from a CD-R and then attempt to
save the embroidery design back to the CD. A CD-R is read only, therefore you will not be able to save the
embroidery design. Save the embroidery design to another medium .

GE021 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Save has a name that has already been used. Replace
the existing embroidery, or choose a new name before saving.

GE022 Embroidery is too large or will not fit in hoop.

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you choose Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again. Alternatively, change the size
of the hoop.

GE023 The file already exists. Do you want to replace it?

This message appears if an embroidery you are trying to Export has a name that has already been used. Replace
the existing embroidery, or choose a new name before exporting.

GE024 Exporting to XX failed. The design was too big for the export format.

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example the .sew or Pfaff (.pcs) file format. If you attempt to save a file in this format that
is bigger than the largest available hoop size, or has more stitches than are allowed, this message will appear.

GE025 Print. Embroidery is too large or will not fit in hoop.

This message appears if the embroidery on screen is partially outside the selected hoop. Move the embroidery
completely within the four blue corners of the work area and try again, or change the hoop size

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE027 Not For Sale. This is a Dealer version of the PREMIER+™ 2 Embroidery
System and not for retail sale. If you are not a certified registered PREMIER+™ 2
Embroidery System dealer you are not entitled to use this software. Please
contact your local dealer for further information.

This message means that the app is a dealer only version for demonstration and training purposes, and is not
available for retail sale. Please contact software support for further information.

GE028 Could not understand the string XX.



This message appears if the value entered in a number box is outside the valid range, or is not a number.

GE029 The file doesn’t exist.

This message appears if the desired embroidery is not where the app expects it to be, for example if an
embroidery was saved to a network drive, then deleted or renamed. The message would appear if you tried to
load the embroidery from the Open Recent list on the File menu.

GE030 Unrecognized file format.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE031 Not enough memory available to perform function.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE032 Cannot open stitch file.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE033 Unrecognized file extension.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery

GE034 Stitch file is corrupt.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE035 Stitch file XY coordinates incorrect.

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GE036 The document "xx" could not be opened.

This message appears if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE037 The file "xx" is locked. If you want to make changes to this document,
click Unlock. To keep the file unchanged and work with a copy, click Duplicate

This message appears when trying to edit an embroidery which is locked, or is on a read-only medium such as a
CD-R. Unlock the embroidery before editing, or duplicate it, and then edit it, if it is on a read-only medium

GE038 The file "xx" is on a read-only volume and cannot be unlocked. You can
duplicate this document and edit the duplicate.

This message appears when trying to unlock an embroidery which is on a readonly medium such as a CD-R.
Duplicate it, then edit and save it.



GE039 Information About Colors in PREMIER+™ 2 Embroidery System Files

The PREMIER+™ 2 Embroidery System will display threads in a file in the same way on any computer where it is
installed. That is, the colors used will be the same even if they are reproduced slightly differently on different
monitors. You can print a worksheet to see the colors and color names used in a particular design. This is true,
even if you do not have all the threads in a design defined in the database on your computer. This is because a
PREMIER+™ 2 Embroidery System design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

» Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the PREMIER+™ 2 Embroidery System
where you can change colors, as follows:

» Editing apps: PREMIER+™ 2 Embroidery and PREMIER+™ 2 Modify
o Design apps: PREMIER+™ 2 Create

» Adding/Editing Thread: PREMIER+™ 2 Thread Cache

» Generating fonts: PREMIER+™ 2 QuickFont

In GEO40 and GE041 are some situations you may encounter according to the availability of thread definitions, as
categorized above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

GE041 | have a vp4 or vp3 embroidery from another user that uses a custom
thread definition they designed.

If you attempt to change the color the nearest match will be selected. If desired, select a replacement thread.

GE042 Do you want to remove all points from your demo? This cannot be
undone.

This message appears if you use Reset My Demo in Life View. Click Yes to continue, or No to keep your existing
My Demo.

GE043 How do | backup a My Demo animation?

The My Demo animated preview is stored in the AnimationPath.txt file in the folder
/User]/Library/ApplicationSupport/VSMSoftware/Premier+2/System. This location may not be visible on your
Mac®, but you can find it using the following steps.

To Backup a My Demo Animation

1. Open the Finder window.

2. Open the Go menu.

3. Hold down the Option (Alt) key, and choose Library.

4. Browse to /ApplicationSupport/VSMSoftware/Premier+2/System.
5. Copy the file AnimationPath.txt to your backup location.

GE044 \Where are my recent pictures?



| recently captured an image using a camera in a PREMIER+™ 2 Assistant.

Images that have recently been captured using your webcam in one of our PREMIER+™ 2 Assistants can be
found in /User]/Library/Containers/com.apple.ImageKit.RecentPictureService/Datal/Library/Images/Recent
Pictures. This location may not be visible on your Mac®, but you can find it using the following steps.

To Manage Recent Pictures Taken By Your Webcam

. Open the Finder window.

. Open the Go menu.

. Hold down the Option (Alt) key, and choose Library.

. Browse to
/User]/Library/Containers/com.apple.ImageKit.RecentPictureService/Data/Library/Images/Recent
Pictures.

. Open the View menu in Finder.

. Click on the as Icons option to have a better view of the individual images.

. Manage the .png or .tiff files in that folder as needed.
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The process of exporting SHV designs to a USB Embroidery stick may take up to a few minutes.

When the 'Exporting to USB Stick' progress bar disappears; then the designs have written to the USB Embroidery
Stick.

Be sure to go to Finder and Eject your USB Stick before removing it from the computer and inserting it into your
Designer 1 USB machine.

It may be that your USB Embroidery Stick is running very low on space.

It is advisable to format your USB Embroidery Stick to ensure that it has enough space for your SHV designs to
be written.

The following formatting process will delete ALL files/folders from your USB Embroidery Stick. If you have any
files/folders that you wanted to keep, then backup them up before proceeding with the following procedure.

1. Eject and then remove all USB Sticks/Hard Disk from your Mac®.

2. Insert your USB Embroidery Stick that you would like to format.

3. Open Finder.

4. Click on the Go menu.

5. Click on the Home option.

6. Browse to .../Premier+2/Samples/Finder/Stitch/Animals

7. Control+click on any .vp3 or .vp4 file shown. A context menu will appear.

8. Move your mouse to the Services sub-menu

9. Click on the Premier+ 2 Convert option. APREMIER+™ 2 Convert box should appear.
10. Click on the ... button in the Output File Type section.

11. Select Husqvarna Viking Designer 1 (.shv) from the list.

12. Click on the USB Stick button in the Select Device section

13. Click on the Format button in that section. A warning will appear.

14. After you have read and accepted the warning, click Yes to start the Formatting process.
15. The formatting process should take less than a minute.

16. When it is complete, try to export your SHV designs again to the USB Embroidery Stick.

The measurements are taken from the settings on the Appearance tab in PREMIER+™ 2 Configure.
To change those settings, do the following:
1. Go to the Launchpad.



2. Open PREMIER+™ 2 Configure.
3. Click on the Appearance tab.
4. From the Show Measurements In: section, either choose Millimeters (mm) or Inches (“).

GE048 | have a Husqgvarna Viking Designer | machine; how do | create a SHV
design?

You would need to choose Husqvarna Viking Designer | from the Export dialog:

. Click on the File menu

. Choose Export.

. Select Husqvarna Viking Designer | (.shv) from the drop-down list.

. Depending on which device (floppy disk or USB Embroidery Stick) you are write to, you will click on the
appropriate icon for that device.

5. [Optional] to backup the items already on your floppy disk/lUSB Embroidery Stick; click on the Read

Stick or Disk button and then choose the location to save your backup to.
6. Click on the Next button to start writing to that device.

N.B. The instructions above are only applicable to PREMIER+™ 2 EMBROIDERY, PREMIER+™ 2 EXTRA or
PREMIER+™ 2 ULTRA owners with activated software.
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GE049 | cannot see all my PREMIER+™ 2 icons in Launchpad.

Launchpad shows the icons for all your installed software on your Mac® computer.

Depending on how many apps you have installed on your Mac®; the icons may span more than one page in
Launchpad .

When there is more than one page of icons available in Launchpad , there will be a number of ‘dots’ —
representing all the available Launchpad pages. The dot for the current page will be highlighted, click on one of
the other dots to navigate between pages.

GE050 Error: "Exporting to XX failed."

This message appears if, for instance, you attempt to save the design to a CD. A CD-ROM is read only, therefore
you will not be able to save the design.

GE051 Error: The value '™ is invalid. Please provide a valid value.

This message appears if the number entered is above or below the permitted range, or a character other than a
number was used.

GE052 Error: The value * is too small. Please provide a valid value.

This message appears if the number entered was smaller than the permitted minimum.

GE053 Error: The value * is too large. Please provide a valid value.

This message appears if the number entered was larger than the permitted maximum.

GE054 Error: The value mm’ needs to be in the range XX to YY mm. Please
provide a valid value.

This message appears if the value entered in the number box is below the permitted minimum or above the
permitted maximum.



IN001 This package will run a program to determine if the software can be
Installed.
This message appears when installing the Samples or Bonus Designs. Click Continue to proceed with the

installation if the software has already been activated. Otherwise, activate your software, and then install the
Samples or Bonus Designs.

IN021 Where are my samples/backgrounds/documents/bonus designs?

When installing any of the PREMIER+™ 2 Embroidery System samples/backgrounds/documents/bonus designs
the files should be installed in subfolders of the folder /Users/Home/Premier+2/ (where Home means the account
of the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.

If you are not at the computer with PREMIER+™ 2 Embroidery, you can enter your e-mail address and password
to find your registration details.

SE001 "When using Border Embroidery only the Create Overlay Border option is
available."

This may happen with some embroideries containing holes or appliqué areas. Where multiple lines are found,
there cannot be a single external or internal border, so only the Create Overlay Border option is available for use.

sT004 ColorSort does not work for the multi-color monogram that | created

When creating multi-color lettering, ensure that the Trim Connection is selected. If Running Connection is
selected, you will not be able to ColorSort the lettering.

sT006 \When | ColorSort an embroidery the number of color blocks produced
varies

The ColorSort process does not just put the same color blocks together. It checks for overlap between areas,
therefore depending on the overlaps, the final number of color blocks may vary, even if you are Combining a
similar number of SuperDesigns or monograms.

sT011 Error: "Embroidery is too large or not in the hoop"

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you Export. This message would then appear. Move the
embroidery completely within the four blue corners of the work area and try again.



SsT012 Error: "Embroidery is too large or will not fit in hoop" when printing

This error can occur when an embroidery design(s) are partially outside of the hoop area when you try to print.
Move the design(s) so that they are entirely within the hoop area; or alternatively use a larger hoop.

sT038 | have selected the correct hoop size, but the graphical representation
does not look the same as my real hoop

This will happen if you choose a Universal Hoop that is the same size. The Universal Hoops are shown as plain
hoops of the selected size. Use Hoop Selection to choose the desired hoop size, but do not choose a Universal
Hoop.

sT072 | did not select all the embroideries | wanted with Box, Freehand or
Freehand Point Select.

The embroideries must be fully enclosed by the selection line to be selected as part of a block. If even the
smallest part of an embroidery is outside the line, then it will not be selected.

TCc127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE 3 Embroidery System as a result of upgrading to the latest
Mac OS Update

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True 3 Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery 3 Software section, download the latest TruEmbroidery3Software32.pkg file.

. Close down all TruEmbroidery 3 System Apps.

. Install the TruEmbroidery3Software32.pkg file that you just downloaded.

. Open TruE 3 Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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TC129 Delete My Fill: Are you sure you want to delect the selected pattern? This
action cannot be undone.

This message appears when you delete a My Fill pattern from the Manage My Fills dialog. Click Yes or No, as
desired.

TM001 The embroidery | want to work with appears too small on the screen.

Make sure the PREMIER+™ 2 Modify window is maximized by choosing Window > Zoom. Click Zoom To Fit to
expand the hoop so it fills the work area. Also, choose a Hoop Size in Hoop Selection that is suitable to the
embroidery size.

TM002 | find it hard to select the part of the embroidery | wish to edit.

Many functions of PREMIER+™ 2 Modify can be used to help see sections of embroideries more easily. They
include the Zoom Commands, as well as the Draw Next Color Block and Draw Previous Color Block, Draw Range



and Ghost Mode. The Design Player can also be used to help run through embroideries to find the required stitch
or command.

The different methods of selection (Box Select, Color Block Select, Select Stitches, Freehand Select, Freehand
Point Select and Select All Visible) are also useful for different situations.

TM003 | selected part of an embroidery, then tried to Compensate the block. The
compensation has been applied to the whole embroidery, not just the area
selected.

Compensation works on the visible part of an embroidery. Hide stitches with Draw Range, Draw Next Color Block,
or turn colors off by deselecting them in the Color Select area on the Design window, to isolate a specific area
before using this function.

TM004 | selected part of an embroidery, then tried to Break Up Stitches. Stitches
have been broken up in the whole embroidery, not just the area selected.

Break Up Stitches works on the visible part of an embroidery. Hide stitches with Draw Range, Draw Next Color
Block or turn colors off to isolate a specific area before using this function.

TM005 | cannot select the desired color using the Color Block Select function,
because one color is on top of the other.

Use Draw Next Color and Draw Previous Color or turn colors off in the Color Select area on the Design window to
isolate the desired color area, then click Color Block Select to select those stitches.

TM006 Some of the stabilizing lines on my cutwork are placed in the wrong
sequence.

If you use ColorSort on multiple areas of cutwork with stabilizing lines, in some circumstances the stabilizing lines
may be merged. When changing the order of designs with multiple cutwork areas, use the arrows in Color select
to set the order of the color blocks.

TM007 | used Box Select around an area, but selected some stitches | didn't
want. Undo is dimmed so | can't click it.
To cancel a stitch block selection made using Box Select, Color Block Select , Freehand Select, Freehand Point

Select or Select All Visible, click anywhere in the currently active embroidery, but outside the box showing the
selected stitches. The stitches will no longer be selected.

PREMIER+ 2 QuickFont

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

ccoo1 Warning. Some PREMIER+ 2 apps still appear to be running. Do you
really want to reset all modules?

This message is displayed if you select Reset All Apps in the Utilities tab while other PREMIER+™ 2 Software
apps are running. Click Cancel, or use Quit Open PREMIER+ 2 Apps to close all open apps.



cco10 When upgrading my Mac® operating system, my activation was lost.
What should | do?

Update the Applications in your PREMIER+™ 2 Embroidery System to the latest version. Then, in PREMIER+™
2 Configure select Activate and reactivate using your current Activation Code.

Before PREMIER+™ 2 Mac Applications 12.1.1, an activation could be broken when macOS was updated. This is
resolved in version 12.1.1.

We strongly recommend that after you update to 12.1.1 from 12.0 or 12.1, you run Activate again in PREMIER+™
2 Configure using your current Activation Code, to move to the new activation method.

Note: This updates your current activation, it does not use a new activation.

cco11 Why does my Mac® show PREMIER+™ 2 Embroidery Free?

Your Mac® will show PREMIER+™ 2 Embroidery Free if you do not have a license for the PREMIER+™ 2
Embroidery System, or if your activation has become corrupted.

If you are using PREMIER+™ 2 Embroidery Free, you do not need to do anything.

To activate or repair your installation, install the latest version of Applications for your PREMIER+™ 2 Embroidery
System. In PREMIER+™ 2 Configure select Activate and activate using your Activation Code.

Note: Repairing an existing activation will not use up a second activation.

EC003 Can | set the PREMIER+™ 2 Machine app to start automatically when |
turn on my computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System area, click on Users & Groups.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right pane of that window.

. Click on the + icon on the right pane of that window. An Open dialog will appear.

. On the left pane - under the Favorites section; click on the Applications entry.

. In the right pane, scroll down the list of apps until you come to the PREMIER+™ 2 Machine entry.

. Select the PREMIER+™ 2 Machine entry and click on the Add button.

. You will now see PREMIER+™ 2 Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.
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When you next log into your computer; the PREMIER+™ 2 Machine app will run automatically.

EC004 Can | connect more than one embroidery machine to my computer with
PREMIER+™ 2 Machine?

No, you are not able to connect two embroidery machines at the same time, and to send a design to the first
embroidery machine and then to the second embroidery machine.

If you want to send an embroidery to two machines, do as follows

1. Send the design to the first machine.

2. Disconnect the USB connection between your Mac and that embroidery machine.
3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the PREMIER+™ 2 Machine app is running. PREMIER+™ 2 Machine appears as a machine
icon in the menu bar.



If PREMIER+™ 2 Machine is not running, start it.

o Click the PREMIER+™ 2 Machine icon in the Launchpad, or double-click the PREMIER+™ 2 Machine icon
in the Finder.

Second, confirm that the PREMIER+™ 2 Machine app is communicating with your embroidery machine.

» Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start PREMIER+™ 2 Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart PREMIER+™ 2 Machine.

EC006 | sent a design to my embroidery machine, but nothing happened.

You can only send a design directly to your embroidery machine if the following folder exists:
ILibrary/Application Support/VsmSoftware/Premier+2/TempSend.
If this folder does not exist, do as follows:

1. Open a Finder window.

2. In the Go menu, hold down the Option key and choose Library.

3. Browse to Application Support/VsmSoftware/Premier+2.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

Now try to send the design again.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMBS5 folder, while for the MC11000 and MC 12000 they must
be placed in the Embf folder.

GE001 | cannot open Melco (.exp) files in the PREMIER+™ 2 Embroidery
software.

The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert to use those designs in your PREMIER+™ 2 Embroidery System software.

GE004 | have changed the screen background color and now | wish to return to
the original light blue.

Use PREMIER+™ 2 Configure to change screen background color. Click the Color block and the Colors window
appears to allow you to choose a color. The color set by default for your PREMIER+™ 2 Embroidery System is
211, 233, 255 (RGB). You can use the RGB Sliders in the Colors Sliders tab to return to this color.

GE005 | can't see the toolbar or some of the icons.



Use Reset All Apps in PREMIER+™ 2 Configure to return the toolbar and windows in the app to their default
settings.

To return the buttons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the
default button set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System apps that are open.

2. Click the PREMIER+™ 2 Configure icon in the Launchpad, or double-click the PREMIER+™ 2 Configure
icon in the Finder.

. Click the Utilities tab.

. Click Reset All Apps.

. Click the Quit Open PREMIER+™ 2 Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some PREMIER+™ 2 apps are still open, a message appears, saying that some apps appear to be
running. Click OK to close all running PREMIER+™ 2 apps, or click Cancel.
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The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

Ge007 When | try to use the number box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired
thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color is replaced with the nearest match in the Import
Thread Range you have set in PREMIER+™ 2 Configure. You can alter it to any other color if desired. To check
for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.

GE039 Information About Colors in PREMIER+™ 2 Embroidery System Files

The PREMIER+™ 2 Embroidery System will display threads in a file in the same way on any computer where it is
installed. That is, the colors used will be the same even if they are reproduced slightly differently on different
monitors. You can print a worksheet to see the colors and color names used in a particular design. This is true,
even if you do not have all the threads in a design defined in the database on your computer. This is because a
PREMIER+™ 2 Embroidery System design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

» Athread from the Thread Database.
» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.



» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the PREMIER+™ 2 Embroidery System
where you can change colors, as follows:

» Editing apps: PREMIER+™ 2 Embroidery and PREMIER+™ 2 Modify
o Design apps: PREMIER+™ 2 Create

» Adding/Editing Thread: PREMIER+™ 2 Thread Cache

» Generating fonts: PREMIER+™ 2 QuickFont

In GE040 and GE041 are some situations you may encounter according to the availability of thread definitions, as
categorized above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

GE041 | have a vp4 or vp3 embroidery from another user that uses a custom
thread definition they designed.

If you attempt to change the color the nearest match will be selected. If desired, select a replacement thread.

GE047 How do | change the measurement in the PREMIER+™ 2 software?

The measurements are taken from the settings on the Appearance tab in PREMIER+™ 2 Configure.
To change those settings, do the following:

1. Go to the Launchpad.

2. Open PREMIER+™ 2 Configure.

3. Click on the Appearance tab.

4. From the Show Measurements In: section, either choose Millimeters (mm) or Inches (“).

GE049 | cannot see all my PREMIER+™ 2 icons in Launchpad.

Launchpad shows the icons for all your installed software on your Mac® computer.

Depending on how many apps you have installed on your Mac®; the icons may span more than one page in
Launchpad .

When there is more than one page of icons available in Launchpad , there will be a number of ‘dots’ —
representing all the available Launchpad pages. The dot for the current page will be highlighted, click on one of
the other dots to navigate between pages.

IN001 This package will run a program to determine if the software can be
Installed.
This message appears when installing the Samples or Bonus Designs. Click Continue to proceed with the

installation if the software has already been activated. Otherwise, activate your software, and then install the
Samples or Bonus Designs.

IN021  Where are my samples/backgrounds/documents/bonus designs?

When installing any of the PREMIER+™ 2 Embroidery System samples/backgrounds/documents/bonus designs
the files should be installed in subfolders of the folder /Users/Home/Premier+2/ (where Home means the account
of the user you are logged in as), however occasionally this may not be the case. This will result in your



samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.

If you are not at the computer with PREMIER+™ 2 Embroidery, you can enter your e-mail address and password
to find your registration details.

TCc127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE 3 Embroidery System as a result of upgrading to the latest
Mac OS Update

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True 3 Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery 3 Software section, download the latest TruEmbroidery3Software32.pkg file.

. Close down all TruEmbroidery 3 System Apps.

. Install the TruEmbroidery3Software32.pkg file that you just downloaded.

. Open TruE 3 Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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TC129 Delete My Fill: Are you sure you want to delect the selected pattern? This
action cannot be undone.

This message appears when you delete a My Fill pattern from the Manage My Fills dialog. Click Yes or No, as
desired.

TQoo1 How do | delete fonts that | have created in PREMIER+™ 2 QuickFont?

You can do this using the Font Manager in PREMIER+™ 2 Embroidery.

1. Open PREMIER+™ 2 Embroidery.

2. In the Letter window click Font Manager.

3. Choose the Category for the font (this will usually be MyFonts).
4. Select the font.

5. Click the Delete button.

6. Click Yes to the removal message.

The font is removed from its font category.

TQ002 How do | create my own fonts in the PREMIER+™ 2 software?
This can be achieved using PREMIER+™ 2 QuickFont.



Open PREMIER+™ 2 QuickFont from the Launchpad or via the Letter tab of the PREMIER+™ 2 Embroidery
Control Panel.

PREMIER+ 2 Thread Cache

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

CA001 This action is permanent and may not be reversed. Do you wish to
continue?

This message appears if you try to delete a thread definition from a My Thread database, or to delete a My
Thread database. If you wish to go ahead and delete the thread, click Yes. Otherwise click No.

CA002 The thread XX already exists in the selected Thread Database. Do you
want to overwrite it?

This message appears if you try to use an existing thread name in a My Thread database. If you wish to
overwrite, click Yes. Otherwise click No.

If multiple threads are selected, to overwrite the names click All, otherwise click None.

CA003 Failed to connect to the Cloud: The e-mail address has been recognized
but the password is incorrect

No connection can be made with the software registration database. A correct email address has been used with
an incorrect password. Check the e-mail address and password, and try again.

CA004 Failed to connect to the Cloud: An error has occurred. Please try again.

No connection can be made with the software registration database. An unknown e-mail address was used.
Check the e-mail address and password, and try again.

CA005 Failed to connect to the Cloud: The e-mail address is incorrectly
formatted.

No connection can be made with the software registration database. The e-mail used is not a valid e-mail
address. Check the e-mail address and password, and try again.

CA006 | receive a warning message when | click the Upload button in Truk 3
Thread Cache

By clicking on the Upload button, you may receive the following message:

"TruE 3 Thread Cache wants to use your confidential information stored in "threads.truembroidery.com"
in your keychain.

The authenticity of "TruE 3 Thread Cache" cannot be verified. Do you want to allow access to this item?"

This message generated by the Mac® operating system; is appearing because you will be prompted to enter your
E-mail address/Password details that you use to connect to the Registration Database.



ccoo1 Warning.
Some PREMIER+

2 apps still appear
N TruE 3 Thread Cache wants to use your to be running. Do

' confidential information stored in

“threads.truembroidery.com” in your keychain. you really want to

_ reset all modules?
The authenticity of “TruE 3 Thread Cache" cannot be

verified. Do you want to allow access to this item? This message is displayed
if you select Reset All Apps
in the Utilities tab while
other PREMIER+™ 2
Always Allow Deny Allow Software apps are running.
Click Cancel, or use Quit
Open PREMIER+ 2 Apps
to close all open apps.
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cco10 When upgrading my Mac® operating system, my activation was lost.
What should | do?

Update the Applications in your PREMIER+™ 2 Embroidery System to the latest version. Then, in PREMIER+™
2 Configure select Activate and reactivate using your current Activation Code.

Before PREMIER+™ 2 Mac Applications 12.1.1, an activation could be broken when macOS was updated. This is
resolved in version 12.1.1.

We strongly recommend that after you update to 12.1.1 from 12.0 or 12.1, you run Activate again in PREMIER+™
2 Configure using your current Activation Code, to move to the new activation method.

Note: This updates your current activation, it does not use a new activation.

EC003 Can | set the PREMIER+™ 2 Machine app to start automatically when |
turn on my computer?

Yes, you can by using the following instructions:

1. Click on System Preferences from your Dock - the icon that looks like a cog.

2. In the System area, click on Users & Groups.

3. Ensure that your user account (listed near the top left section of that window, under Current User) is
selected.

. Click on the Login Items tab - on the right pane of that window.

. Click on the + icon on the right pane of that window. An Open dialog will appear.

. On the left pane - under the Favorites section; click on the Applications entry.

. In the right pane, scroll down the list of apps until you come to the PREMIER+™ 2 Machine entry.

. Select the PREMIER+™ 2 Machine entry and click on the Add button.

. You will now see PREMIER+™ 2 Machine in the list of items that will automatically start when you log in.

10. Close System Preferences/Users & Groups.
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When you next log into your computer; the PREMIER+™ 2 Machine app will run automatically.

EC004 Can | connect more than one embroidery machine to my computer with
PREMIER+™ 2 Machine?

No, you are not able to connect two embroidery machines at the same time, and to send a design to the first
embroidery machine and then to the second embroidery machine.

If you want to send an embroidery to two machines, do as follows

1. Send the design to the first machine.
2. Disconnect the USB connection between your Mac and that embroidery machine.



3. Connect a USB cable between your second embroidery machine and your Mac.
4. Send a design to that second embroidery machine.

EC005 | cannot send a design to my embroidery machine.

First, confirm that the PREMIER+™ 2 Machine app is running. PREMIER+™ 2 Machine appears as a machine
icon in the menu bar.

If PREMIER+™ 2 Machine is not running, start it.

e Click the PREMIER+™ 2 Machine icon in the Launchpad, or double-click the PREMIER+™ 2 Machine icon
in the Finder.

Second, confirm that the PREMIER+™ 2 Machine app is communicating with your embroidery machine.

» Click the machine icon in the menu bar and check that your embroidery machine is listed in the menu. If it
is not, check the USB connection, then choose Quit and start PREMIER+™ 2 Machine again.

Note: If the USB connection between your embroidery machine and computer is temporarily interrupted, you may
need to restart PREMIER+™ 2 Machine.

EC006 | sent a design to my embroidery machine, but nothing happened.

You can only send a design directly to your embroidery machine if the following folder exists:
ILibrary/Application Support/VsmSoftware/Premier+2/TempSend.
If this folder does not exist, do as follows:

1. Open a Finder window.

2. In the Go menu, hold down the Option key and choose Library.

3. Browse to Application Support/VsmSoftware/Premier+2.

4. Control—click an empty area of the screen and choose New Folder from the context menu.
5. Name the new folder TempSend.

Now try to send the design again.

EC008 | exported my embroidery to my USB stick, but | cannot browse to it on
my embroidery machine.

Your embroidery machine may not be able to read USB sticks with a large capacity. Check the manual for your
embroidery machine for information on limitations on the size of USB stick memory.

EC009 | exported my embroidery to my USB stick, but | cannot find it when |
browse the stick on my embroidery machine.

You may need to place the embroidery within a particular folder on your USB stick. For example, on the Janome
MC350E the embroidery files must be placed in the EMB5 folder, while for the MC11000 and MC 12000 they must
be placed in the Embf folder.

GA005 Error "Feature not available in this version."

This message appears when trying to start a module or feature if the PREMIER+™ 2 Embroidery System cannot
detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE001 | cannot open Melco (.exp) files in the PREMIER+™ 2 Embroidery
software.



The Melco format (.exp) extension is also used by default in the Mac operating sytem.
Therefore, you would not be able to open those files via the Open dialog.
In order to use Melco files; use Insert to use those designs in your PREMIER+™ 2 Embroidery System software.

GE002 Some of the items in a menu are dimmed.

Certain items (for example Undo in the Edit menu) are only available once an embroidery design is shown on the
screen.

GE005 | can't see the toolbar or some of the icons.

Use Reset All Apps in PREMIER+™ 2 Configure to return the toolbar and windows in the app to their default
settings.

To return the buttons in the toolbar to their default settings, choose View > Customize Toolbar, and drag the
default button set into the toolbar.

To use Reset All Apps:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System apps that are open.

2. Click the PREMIER+™ 2 Configure icon in the Launchpad, or double-click the PREMIER+™ 2 Configure
icon in the Finder.

. Click the Utilities tab.

. Click Reset All Apps.

. Click the Quit Open PREMIER+™ 2 Apps button to close all open apps.

. Click the Reset All Apps button.

Note: If some PREMIER+™ 2 apps are still open, a message appears, saying that some apps appear to be
running. Click OK to close all running PREMIER+™ 2 apps, or click Cancel.
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The toolbar and windows in your app will have been restored to their original state.

Note: If preferred, to check the toolbar choose View, then choose Show Toolbar if the toolbar has been hidden, or
choose Customize Toolbar to reset the toolbar if icons have been added to or removed

GE007 When | try to use the number box to select a thread number, the wrong
thread shade is selected.

The find thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. The existing thread number is also listed. If
you are attempting to find a thread with only part of the number, the first thread matched may not be the desired
thread. To ensure you select the correct thread, enter the thread number as it appears in the list. Some thread
ranges have prefix characters on the thread number. These must also be entered to obtain an exact match.

GE008 A thread in an embroidery from a friend had a different name or number
when | first opened it.

The thread name or number is changed when the thread is opened if the Thread Range of the selected color is
not found in your thread database. This could happen if the design you are attempting to edit was supplied by
someone with a later version of the thread database. The color is replaced with the nearest match in the Import
Thread Range you have set in PREMIER+™ 2 Configure. You can alter it to any other color if desired. To check
for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GE026 Not enough memory available to perform function.

This message will appear when system resources are low. Close other apps and try again. If this does not work,
try restarting your computer.



GE031 Not enough memory available to perform function.

This message may appear if the embroidery you are attempting to load is corrupt. For example, it might have the
extension .vp4, yet not be a proper Husqgvarna Viking/Pfaff embroidery.

GE039 Information About Colors in PREMIER+™ 2 Embroidery System Files

The PREMIER+™ 2 Embroidery System will display threads in a file in the same way on any computer where it is
installed. That is, the colors used will be the same even if they are reproduced slightly differently on different
monitors. You can print a worksheet to see the colors and color names used in a particular design. This is true,
even if you do not have all the threads in a design defined in the database on your computer. This is because a
PREMIER+™ 2 Embroidery System design has complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

» Athread from the Thread Database.

» Athread from the Thread Database that is not on your own Thread Database because your database is out
of date.

» A custom thread defined in the file that does not appear in your Threads database.

The availability of threads in the Thread Database will only affect parts of the PREMIER+™ 2 Embroidery System
where you can change colors, as follows:

» Editing apps: PREMIER+™ 2 Embroidery and PREMIER+™ 2 Modify
o Design apps: PREMIER+™ 2 Create

» Adding/Editing Thread: PREMIER+™ 2 Thread Cache

» Generating fonts: PREMIER+™ 2 QuickFont

In GE040 and GE041 are some situations you may encounter according to the availability of thread definitions, as
categorized above.

GE040 | have a design from another user that uses threads from the Thread
Database that | do not have.

Use Smart Update to find and download the latest thread database, which you can then install.

GE041 | have a vp4 or vp3 embroidery from another user that uses a custom
thread definition they designed.

If you attempt to change the color the nearest match will be selected. If desired, select a replacement thread.

GE047 How do | change the measurement in the PREMIER+™ 2 software?

The measurements are taken from the settings on the Appearance tab in PREMIER+™ 2 Configure.
To change those settings, do the following:

1. Go to the Launchpad.

2. Open PREMIER+™ 2 Configure.

3. Click on the Appearance tab.

4. From the Show Measurements In: section, either choose Millimeters (mm) or Inches ().

GE049 | cannot see all my PREMIER+™ 2 icons in Launchpad.

Launchpad shows the icons for all your installed software on your Mac® computer.

Depending on how many apps you have installed on your Mac®; the icons may span more than one page in
Launchpad .

When there is more than one page of icons available in Launchpad , there will be a number of ‘dots’ —
representing all the available Launchpad pages. The dot for the current page will be highlighted, click on one of



the other dots to navigate between pages.

IN021 Where are my samples/backgrounds/documents/bonus designs?

When installing any of the PREMIER+™ 2 Embroidery System samples/backgrounds/documents/bonus designs
the files should be installed in subfolders of the folder /Users/Home/Premier+2/ (where Home means the account
of the user you are logged in as), however occasionally this may not be the case. This will result in your
samples/backgrounds/documents/bonus designs being installed into the root of your hard disk, for example
Macintosh HD.

If this occurs, you may either load the samples from their current location, or move/copy the folder(s) to the
correct location.

Please note that by default the Mac® will replace the content inside the folder, therefore it is recommended to
make a copy of your files before replacing.

RE001 How do | change my personal information for my software registration?

Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.

If you are not at the computer with PREMIER+™ 2 Embroidery, you can enter your e-mail address and password
to find your registration details.

TCc127 Clicking on the Register, Activate Dongle or Smart Update buttons have
no effect

This may occur on an existing installation of the TruE 3 Embroidery System as a result of upgrading to the latest
Mac OS Update

To resolve this issue; do the following steps:

. Go to http://www.truembroidery.com

. Click on the Downloads link at the top of the page.

. Click on the True 3 Download Portal button.

. Enter your registered E-mail Address.

. Enter your Password. Click Next.

. Click Next again.

. In the TruEmbroidery 3 Software section, download the latest TruEmbroidery3Software32.pkg file.

. Close down all TruEmbroidery 3 System Apps.

. Install the TruEmbroidery3Software32.pkg file that you just downloaded.

. Open TruE 3 Configure and confirm that clicking on the Register, Activate Dongle and Smart Update
buttons now open up a window in the background.
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TC129 Delete My Fill: Are you sure you want to delect the selected pattern? This
action cannot be undone.

This message appears when you delete a My Fill pattern from the Manage My Fills dialog. Click Yes or No, as
desired.



